Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional

Ver. 3.3

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Windows XP.

» indicates the selection procedure of the menu.

Example: [File] menu » [Exit].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 . Marks helpful information when a problem
arises.

@ : Marks information that should be read

A1/
/TN

before use.

Marks additional information you may find
helpful.

. Marks tips for using the software skillfully.

& Switching Between Pages
Click on arrows on the bottom right of the screen.

(D : next page
€D : previous page

: return to a page you had previously
displayed

® Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the [Troubleshooting] » [Shortcut Key
List] in the Help for a list of shortcut keys which
are helpful for quick operation.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW
image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for the RAW image, too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim an image and change its size
Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Windows Vista*!
oS Windows XP Professional/Home Edition*?2
Windows 2000 Professional*3

PC with one of the above OS preinstalled

Computer | . Upgraded machines not supported
cPU Windows Vista 1.3GHz Pentium or higher
Windows XP, 2000 | 750MHz Pentium or higher
RAM Windows Vista Minimum 1GB
Windows XP, 2000 | Minimum 512MB
Display Screen resolution: 1024 x 768 pixels or more

Color quality : Medium (16 bit) or more

*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition
*2 Compatible with Service Pack 2 *3 Compatible with Service Pack 4

Supported Images

This software supports the following image types.

Image type/Camera used Extension

EOS-1Ds Mark Il EOS-1D Mark llI
EOS-1D Mark I N EOS-1Ds Mark Il
EOS-1D Mark I EOS 5D
EOS 40D EOS 30D
EOS 20D/20Da .CR2
EOS DIGITAL REBEL XSi/450D
EOS DIGITAL REBEL XTi/400D DIGITAL

RAW images | EOS DIGITAL REBEL XT/350D DIGITAL
EOS D6000*! EOS D2000*!
EOS-1Ds EOS-1D TIF
EOS 10D
EOS DIGITAL REBEL/300D DIGITAL CRW
EOS D60 EOS D30 :
PowerShot Pro1*2

- Exif 2.2 or 2.21-compatible JPEG
JPEG images images JPG, .JPEG
TIFF images | Exif-compatible TIFF images TIF, .TIFF

*1 Images converted to RAW images that have the “.CR2” extension in CR2
Converter. For information on CR2 Converter, refer to Canon’s web site.
*2 You cannot edit with the DPP RAW image adjustment function.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00




Contents at a Glance [ i

e a8
-*‘*-'
- Introduction

Downloading Images to Your Computer Erase dust shot with the image - p.61, p.63
Download images by connecting your cameraand ~ _, 07 Erase unwanted parts of an image - p.65 Contents at
computer Reduce image noise - p.56 a Glance
Download images using a card reader -p.9 Correct lens aberration - p.57
Use a Picture Style file = p.53 Basic
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Quickly enlarge parts of an image = p.l1l Edit an image while comparing the image before and _, 0.49
Sort images (check marks) - p.17,p.18 after adjustment ' Advanced
_Display an image _shot simultar_1eou5_|y as a RAW - p.20 Synchronize multiple images = p.50 Operation
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Check shooting information such as the shooting date =» p.10, p.21 of shooting '
Processing
Editing RAW Images (Adjusting) Printing Laggelrl::r;gsers
Adjust brightness{darkness =>p.12, p.24 Print well on a Canon printer = p.39, p.68, p.69
grsmgr?;etcﬂj tlgcic?gggsértg?em y ng \',:Vfl'g:‘:)"r?’n:ﬁ]‘g"duce the color of the subject ) 39 1 68, .69 jSditing _
agii?ggt)the modulation and contrast of colors => p.27 @ Print with the shooting information = p.66 Images
Make skin tone look healthier (color tone) ->p.27 W Print a .thumbnail list of images _ = p67
Make the image colors more vivid (color saturation) ~ =» p.27 Qﬁr?tri?])élrrr;astjlttst]e color seen on screen with your ->p.74 Reference
Make an image sharp (sharpness) = p.29
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Change an image to black-and-white or sepia tones Co.n\./ert a RAW image to a JPEG image = p.38,p.80
(monochrome) Edit in Photoshop = p.65, p.81
Trim parts of an image (trimming) =*p.35 Perform batch processing - p.80 @ @
Specify an aspect ratio that matches the size of the - .35 Edit (adjust) a JPEG image ->p.84
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1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Double-click the desktop icon.

e .

S Double-click

[

DPP starts up and the main window ([Folder] window) appeatrs.

\ 4

Main window ([Folder] window)

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.33)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

)
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and Start up EOS Utility.

download the images saved on the memory card inside the camera. Select the [Tools] menu » [Start EOS Utility].
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

Introduction
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Select the save destination for the images.
Select the save destination in the folder area on the left of the B1ic
main window. Ope

tion

When creating a folder, refer to p.45.

7’| Digital Photo Professional - [C:\Documents and Settingsicanoniy Document Advanced
File Edit Yiew Bookmark Adjustment Tools  Window  Help Op eration
EQOS Utility starts up.
Select all Clear 3l 4 P Img%\éaggﬁidn g
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o T y and Printing
@ Deskion @ EOS Utility ]
[ A
7 "31 M [:f: ;“122“ Control Camera Processing
o — Large Numbers
& of Images
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF
electronic manual).

Download images.
[@# EOS Utility — EOS XXX

‘ Control Camera

Starts to download images ClICk

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-Z\@/:- Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

ﬁl You cannot start up EOS Utility in the [Collection] window
(p.6, p.33).
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Introduction

Downloading Images Using Your Card Reader Display the images downloaded to your computer.
_ _ _ In the [DCIM] folder copied to your desktop, select the folder

Youdcan also download images to the computer using a third-party card where the shot images are saved.

reader.

Contents at
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i Digital Photo Professional - [C:\Documents and Settingsicanoniby Documen

File Edt View Bookmark Adjustment Tools Window Help

Load the memory card into the card reader.
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Folder | Collection{l)
EEm
() My Documents
[ ' My Camputer
2 et Advanced
g R
= e EOS_DIGITAL (Fi)
B3 pcIm
() Shared Documents
{2 My Documents
- N8 letwark Places
; %y HetwerkP: Advanc_e_d
\ o T Image Editing
| o and Printing
Open [My Computer] » [EOS_DIGITAL] and drag the |
[DCIM] folder to the [Desktop]. < Images in the folder are displayed in the main window of DPP. Processing
Large Numbers
=" Digital Photo Professional - [FADCIM] of Imag es
File Edit View Bookmark Adjustment Tools Window Help
Editing
JPEG/TIFF
Edit image ool Selact all Claar all Im a.g es
windaw
Faolder Collection(0)
[ @'.Des.létop
() My Documents Reference
= _’1 My Compuker
_g 3% Floppy (a1
“e WINDOWS 5P (i) M
% Local Disk (D) :@: Checking before downloading images
L CO Drive (E:) |ndeX
(=) e EOS_DIGITAL iF: . . . . .
) By selecting the memory card folder directly in DPP, the images in the
i) Shared Documents H H H _
by Decumsents folder are displayed in DPP and you can check the shot images.
(-8 My Network Places

The [DCIM] folder is downloaded to your computer. @ Copying to your computer may take time when there is a large @ @

. . L number of shot images saved in the memory card.
All d in fold t de the [DCIM] folder. . ,
Images are saved in folder units inside the [ I folder For details on the [DCIM] folder structure and the file names of 6}

shot images, refer to “Folder Structure and File Names in the o
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).



Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

] ] Rotate selected image
Main window

High qualty __ Foecips dita es B of mages: 15 Pt of seleited magts |

Click to select the image

Display thumbnails of all the images inside the
folder selected in the folder area on the left

|§| When aspect ratio information is attached to the shot image with
the EOS-1Ds Mark Il or EOS-1D Mark I, the image is displayed
as a trimmed image (p.35, p.92).
For a list of main window functions, refer to p.103.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu P desired item.

=» The display changes to the selected item.

)

Introduction

Contents at
a Glance

ic
Opernation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

10




Enlarge and View an Image in the Edit Window

The edit window appears.

v

Edit window

Digital Phots Professionsl - [£:\Documents and Setiigs\camnibly Decsents iy Picturrs P hoto oo

2800, 7711 $8192.159  veghquasy R Adose ROB

sex_sea\G_0001,CRZ]

Double-click

Tool palette

It may take time for the image to redraw itself.

Click the [Z3] in the upper right of the window to close the edit

window.

@ For a list of edit window functions, refer to p.106.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

Aoc ety 45 aud Setting g1 anatidy Do e L 001, CH: 7] e

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

® Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

— Change the enlargement
display position by
dragging

My

== To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.72).

)
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [[ % ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
| RGE | NRLenz

Brighthess adjustment [|3II’ Reverts the image to

[ J] Tl the original settings
Drag the slider left or right

YWhite balance adjustrnent =)
2|
Shot settings v
Picture Styls =1 |
Standard v

-10.0 -0 -6.0 -40 -20 00 20 4.0

Contrast () J
[JLinear

Calartone: {0y J

Colar saturation: {0 J

Sharpness:i(1) J

The image brightness changes in real time according to the
amount of adjustments.

"2 The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.77).

ﬁl For a list of tool palette functions, refer to p.107.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Introduction

Contents at
a Glance

Save (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.21)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

© Convert and save (p.38)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process* (p.80)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

You can save * in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.44)

Print using a Canon inkjet printer (p.39, p.42)

Print with a high-end Canon printer (p.68)

Print with shooting information (p.66)

Printing a thumbnail list (contact sheet printing) (p.67)

Exiting DPP

In the main window, select the [File] menu » [EXit].

( )

=» DPP exits.

"2 Exiting DPP without saving adjustments to images

A confirmation dialog box for saving the images appears. Select [Yes to
all] to save the adjustment contents (recipe) to all the images adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.................c....... 16
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into three groups.

Display the quick check window.
Select the [Tools] menu » [Start Quick check tool].

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

215 C:\Decuments and Settings\canonWy Documests\WMy Plctuses P hotokoo _xon!

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

—— Double-click

The area you double-clicked is enlarged to 50% view.

Double-click again to revert to the full view.
@ To change the display position, drag on the image.
@ To exit, click the [OK] button.
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AL/

-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).
You can change the enlargement ratio to 100%, when an image is
enlarged (p.72).
For a list of quick check window functions, refer to p.109.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

Pictures\Photobooor s solMG_0002.CR2

Rotate left Rotate right

» The selected check mark appears in the upper left of the window.

 Click the [Clear] button to remove the check marks.
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

Check mark

The selected check mark appears in the upper left of the image
frame.
Click the [Clear check] button to remove the check marks.

\\I// . . . . .
:@: To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

The images are arranged in the order according to the selected
item.
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Sort item

Check mark1 -
Check mark3

Description

Images with check marks take priority and are
sorted in number order.

Shooting Date/Time Images are sorted by shooting date and time

from the earliest.

File name Images are sorted by file name in alphanumeric
order (Oto 9 » Ato 2).
RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.

-Z\@IE Check mark order

When you assign check marks 1 to 3, the images are sorted as follows:
1 selected: 1»2-3
2 selected: 2—1-3
3 selected: 3—-2—>1

Arranging Freely

Drag and drop the image to the desired location.

—

E—

rognauaty  Foeiips Sk Yan Pl of mages. 15 P of Bt maghs ¢

% The image moves to the desired location.

© You can also select multiple images (p.18) and move them.

® The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.

©® Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

A/

E@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in Preferences to maintain
the order of images without changing the image file names (p.72).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.82).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu » [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences gj

General settings Tool palette Color management
Grid pitch
. Pixels(8-258)
Image selection status
[¥lImages opened in Editwindow remain selected in main window
Magnification in Editwindow
(5 Fit to windo O 50% )100% ) 200% ‘
Magnification when the EditEdit image window is double-clicked
) a0% (®100% ) 200% ‘
RAN and JPEG
[ Display only CR2 images for CR2 and JPEG fleg ofthe sarne name )
Sort order in main window
[[]Retain sort order
Highlightishadow vearning
Highlight 255 (192-255) -
Shadour 0 6 -
Cwick check tool display
@ 50% () 100% {mairé reduction off)

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [XXD] mark (p.105).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

E\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
 Deleting an image (p.45)

* Moving or copying an image (p.46)

» Checkmarks (p.17, p.18)

» Rotating an image (p.103, p.109, p.110)

* Attaching a thumbnail to an image and saving (p.21)

® Images added to the [Collection] window
When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[3B] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.104).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

A/

5@3 The extent of the improvement in quality

The quality is improved for any RAW, JPEG or TIFF image. While the
image quality improves regardless of the thumbnail size (p.10), selecting
[Large thumbnail], with its larger display size, shows the improvement
more clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to add.
You can specify a presetting for JPEG images to improve the
quality of all main window thumbnails (p.70, p.71).

Checking Image Information

Select the image for which you want to check the
Image information.

Select the [File] menu » [Info].

The image information window appears (p.22).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

IMG_0001.CR2 5] IMG_D001.CR2 3]

Shooting Information | petadata

File narne
IMG_0001.CR2
Camera Model Mame
Canon EQS xxx
Firrmware

Shooting DateiTime
HHIREOO00 X 00K

Tv{Shutter Speed)
154005ec.

AufAperure Value)
F13

Metering Modes

Exposure Compensation
-3

150 Speed
200

Lens

Focal Length
17.0 mm

Image size
34486 % 2304

Image Quality

Flash
Off
‘Wihite Balance

AF mode
Ficture Style

Parameters
Tone Curve © -
Sharpness level : -
Fattern Sharpness @ -
Contrast: -
Sharpness: -
Color saturation -

[Metadata] tab sheet

Shooting Information | Metadata
Description

[Diocument Title]
HOO0000(

[Author]
SO00000

[Author Title]
OO0

[Description]
OG0

[Description Writer]
fegieres

[Keywards]
HOO0000(

[Copyright Status]
Public dormain

[Copyright Motice]
OO0

[Copyright info URL]
OG0

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in
Photoshop CS3 after shooting is displayed in the [Metadata] tab
sheet. IPTC* information provides additional comments on
images, such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

* International Press Telecommunications Council (IPTC)

A/

Q= Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

Digital Phists Profiessional - [C:\Documts and Sellings \camnbly Decussnts Wiy Piclurm\Photoboos_xo o\iG_0001,CR7]

Tool palette

2800, 7711 $8172.159  vagh quay R Adobe ROB

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.49).
You can synchronize multiple images and edit while comparing
them (p.50).
Refer to p.106 for a list of edit window functions, and p.107 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window
By clicking the [Tool] button (p.103) in the toolbar on the main window,
the same tool palette that appears in the edit window is displayed and
you can edit images.
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Introduction
Adjusting Brightness Changing a Picture Style
Brightness of an image can be adjusted. Move the slider to the right to If the image you shot is different to what you visualized, you can change Contents at
make an image brighter and to the left to make an image darker. the Picture Style to get closer to what you envisaged. a2 Glance
Even if you have saved the image (p.37) with [Monochrome] (p.28)
RAW |RGB | NR/lens Reverts the image to selected, you can still change to another Picture Style at any point by
ETaNTe ST (= the original settings simply selecting a Picture Style other than [Monochrome]. Basic
Operation
3 — Enter a numerical value :
e mi Reverts the image to
White balance adjustment =) HI Standard the original settings AT ed
, imeale — Select A
Shot settings v PN |
N LT R R
: i!l',l HE 1  h I Advalgge_d
_ _ A ke T mage Editin
Drag the slider left or right B MWM ! anél Printingg
K :’ s U
-100 -30 -0 -40 - Processing
e ) Large Numbers
of Images
[Linear
Colortone (0} uj Editing
Color saturation:{0) I ‘]Fl)nquéLISFF
Sharphess:(0) i
Reference
Index

; 00

Even if the RAW image is from a camera that does not have

Picture Style settings, you can still set a Picture Style as long as @
the RAW image is compatible with DPP (p.3).
ﬁ' The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when You can retain the [Color tone], [Color saturation], [Contrast] and
entering a value). [Sharpness] settings, even if you change the Picture Style (p.73).
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.27).

Portrait

For vivid blues and greens.
Effective for making images of landscapes
impressive.

Landscape

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

Neutral

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

Faithful

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.28).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

Monochrome

(Picture Style file
registered in the
camera)

The name of the Picture Style file applied in DPP
is displayed in [ ].

[Picture Style file
applied in DPP]

Picture Style File

A Picture Style file is an extended function of Picture Style. It is a file that
offers effective image characteristics for an image shot in an extremely
limited scene. Refer to p.53 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

RAW | RGE | MRALens
Brightness adjustment k=) [|
J 0.00
white balance adjustment = Reverts the image to
A meaE the original settings
|_Shutsettings ] N
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.26).

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.27) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.79) when you have selected [Shot settings] from the list
box.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

RAW |RGE | NR/Lens | |
Brightness adjustment =) !II
J
YWhite balance adjustment =) HI Click
. IC
A Register
Shot settings v| Tune...

Click on a point that is to be the standard for white.

190 40 40 A8 <20 80 20 40
Contraat i
Clunssr
r—
Co sumraaon 1

R 3

Reverts the
The coordinates of the cursor position and image to the
the RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [~ ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

)
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Picture Style (= ]| Reverts the image to

Standard v Browse... the original settings

0.0 -B0 B0 -40 -20 0.0 2.0 _40 _
it —— Drag the slider left or
right (9 steps)

[JLinear
Color tone: {0} 3
Colar saturation:{) I
Sharpness:l I

Display the value of the setting

-I\@/E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.24) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.28).

Contrast ()
[Linear
Colar tone: {0y

Colar saturation:{0) ——

Sharpness:{)

Picture Style =
Standard w Browse. .
g koo
] "5“" U n!
r Lk :
. | e B
100 -80 -60 -40 -20 00 20 40

Reverts the image to
the original settings

Drag the sliders left or
right

Display the values of the settings

Color tone: Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.24) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box
(p.24).

Picture Style (= ]| Reverts the image to
" Browse... the original settings

-10.0 -8.0 -0 -40 -20 00 20 4.0
Contrast: (0

[JLinear
Filter effect.(Mone)

(=)
Taoning effect:(Mone) —— ' I i
|

Sharpness:)

Drag the sliders left or
right

Display the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
vellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

© Toning effect: You can create a single-color monochrome
photograph to which color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

== Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] (p.27) slider closer to
the right.
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Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.
Move the slider to the right to make an image harder and to the left to

make an image softer.

Picture Style (=
IStandard

v! Browse. .

Contrast: (0)
[JLinear
Colar tone: (0}

Colar saturation:{0)

Sharpness:)

-100 -80 -60 -40 -2

Display the value
of the setting

Reverts the image to
the original settings

Drag the slider left or right

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness may seem unnatural.

|§| The adjustment range is 0 to 10 (in 1-stop increments).

)
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

Rawwr | RGE [NR/Lens

Tone curve assist

(@] ) E‘rb]l— Reverts the tone curve

Tone curve adjustment S || to the original settings
C_ree J(R](G) Pl
285 High
Standard

Brightness: I 0
Contrast: 3 1]
Hue: 1| ﬂ D _
Saturation: N E1 0o
Sharphess: | E 0

The tone curve changes as adjusted.

~@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [[#8]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.88).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

=’ Digital Photo Professional - [C:\Documents and Settings)

File Edit Wiew Bookmark Adjustment Tools Window Help

Select all Clear all

Click

The main window switches to the edit image window.

Edit the image.

Change the size
Edit image window

Select the image to be edited
The selected image is displayed as an enlargement
in the middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

)
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Introduction

-~ To display an image in an enlargement ratio other than 100%

Double-click the area you want to enlarge. @

Click the [50% view] or [200% view] on the toolbar.
Contents at

a Glance
|§| You can change the way the tool palette is displayed (p.73).
You can change the enlargement ratio when you double-click Basic
(p.72). Operation
With the edit image window, you can only select images from one
Double- folder. To gather images from several folders for editing, refer to
click “Gathering and Editing Images in the Collection Window” (p.33). Ad@ed
For a list of edit image window functions, refer to p.110. Opgggtion
Advanced
Image Editing
and Printing
The area you double-clicked is enlarged to 100% (actual pixel Large Numbers
size). If you wait for a while, it changes to a clearer display. of Images
Double-click again to revert to the full view ([Fit to window]). -
To change the display position, drag on the image or drag the Jfgg}fﬂ.ﬁ:F
enlargement display position (p.107) of the tool palette. Images
To return to the main window, click the [Main window] button on
the toolbar.
Reference
Index
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Introduction

Changing the Thumbnail Display Position to a Horizontal Position Gathering and Editing Images in the Collection Window

Select the [View] menu » [Change thumbnail You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather

Contents at

position]. images from several folders as well as from only one folder, allowing you a Glance
: to work with them efficiently.
] ] ] ] Basic
Select images from the [Folder] window in the main Operation
window, and select the [File] menu » [Add to
collection]. P
Op ion
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
e wree | Editing
If you select [Change thumbnail position] again, the thumbnail JTE%ESFF
display reverts to the vertical position.
Reference
The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet. Index
When you add RAW and JPEG images displayed as a single S
image (p.20), the number of images shown on the [Collection]
tab sheet increases by 2.
You can select several images and add them to the [Collection] @ @
window.
You can also add images to the [Collection] window by selecting @

images, right-clicking with your mouse, and selecting [Add to
collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window. 33



Select the [Collection] tab sheet.

=" Digital Photo Professional - [C:\Documents and Settings
File Edit Wew Bookmark Adjustment Tools  Window Help

Select all Clear all

window 3 =
| |
{2} Deskiap
= B Iy Documents
=) My Music -
=] Mz Dby o L

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

Digital Phatn Professional - Callection
fle [t Yew [oomuk Adustment Jook Window Help

High qualiy Fetipe data s Humber of images: 7 Number of selecied images: 1 CHYH

Edit the images.
You can now edit the images displayed in the [Collection]
window.

A/

== To remove images from the [Collection] window

Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, right-
clicking with the mouse, and selecting [Remove from collection] from the
menu that appears.)

Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

® Images brought together in the [Collection] window are

retained until you exit DPP
When you exit DPP, the gathered images disappear from the
[Collection] window, but this removal from the [Collection] window
does not mean that the original images themselves have been
deleted.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window
are all applied to the original image.

|§| You cannot use the following functions in the [Collection] window.
e Starting of EOS Utility (p.7), or synchronizing of folders with EOS
Utility
» Batch change the file name of images (p.82)
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with the
EOS-1Ds Mark 11l or EOS-1D Mark lll, the trimming range based on the
aspect ratio information is displayed.

Select the image to be trimmed.

Open the trimming window.
Select the [Tools] menu » [Start Trimming tool].

The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.
Trimming window

1715 C:\Becuments and Settings\Wy Documents\y Pictwreshono o adIMG_0001.CR2

__Cancel

—Select a
trimming
ratio

— Drag the
trimming
range

10537, S0 o 30, 16 (90 5065 1.50)

© The trimming range can be moved by dragging.

@ You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

© List of aspect ratios (width : height)

[Free]: You can trim an image to
any size, regardless of
the selectable ratio.

[Custom]: You can trim an image at
the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.105).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.39).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.105).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.38).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark I, the set trimming range based
on the aspect ratio information is displayed. However, since the image
is not actually trimmed, you can change the trimming range or revert
to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

~
-

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.77) can be saved as a separate file from the image
and loaded and applied to another image (p.78).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.35) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.52 to p.57) and the dust
erase processing explained in Chapter 3 (p.61 to p.65) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

The [Convert and save] window appears.

Specify the necessary settings, and then click the
[Save] button.
By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.
oA BEx
—— > >

@
My Recent
Docurner ks
DE%D
—— Select the save
= destination

<) (Cs==_}— Click and save

Quality setiing

Image guality 1 & g

Enter a file name and
Output resalution @ dpi []Embed ICC profile in image Select an |mage type

Resize setting

=» The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

By saving as explained on this page, a trimmed image (p.35) or
dust-erased image explained in Chapter 3 (p.61 to p.65) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which
occurs when you convert and save an image as a JPEG (p.70).
You can batch convert and save multiple images (p.80).

For a list of [Convert and save] window functions, refer to p.111.

Introduction

Contents at
a Glance

Basic
Operation

Adv ed
Op ion

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

38




Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.23), so the “original image data itself” remains
unaffected.

Also, the trimming range information of a trimmed image (p.35) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.37) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with the Canon inkjet printers compatible with the Canon printing
software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how
to print photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.42)
Printing Photographs with a Printer other than the Canon Inkjet
Printers (p.44)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint EX
(hereinafter, “EPP EX”) :
Simple printing of RAW images
Printing with faithful colors
® High gquality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

39




Select the image to be printed. In [Print Quality], select [Quality Priority].
Preferences [g|
Start up EPP EX_ Frint |;5ué|vance|.:|
Select the [File] menu » [Plug-in printing] » [Print with Easy- B poclinibpoce bujecos !
. Murber of copies : -1 £ opies
PhOtOPrInt EX] Printing Order : |By Date v|
Amount of extenzion of borderless printing : | Drefault e |
Frirt Guiality : Select
Optior... Quahty
Priority

[ Ok ] Cancel ] [ Help I
|
( ] Click to close the window

- Specify the number of sheets to be printed, and then
click [Select Paper].

EPP EX
EPP EX StartS up. B Bew Phate Print - Lasy PhatePrint [X
In the EPP EX window, select the [File] menu » - . *”"f”“*
[Preferences]. o W
M@aigs ng
D Lo e | Cod reE fhshes -v.mm -emeq @7_ C“Ck tO
‘ increase the
ﬁ& “ é g number of
cacilic aollca il ‘_" =i | e e sheets to be
h printed
[ ] Selectors 15 magels] =
,Mjﬂifhgngﬁmﬂ‘d
The [Preferences] window appears. Click

—
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Select the paper type, and then click the [Layout/
Print] button.

% bew Fhato Print - Lasy Phatofrint [X

Exf Print

Far L
TiBem amy

[rer——

—

Click

Specify the layout, and then click the [Print] button.

% bew Fhato Print - Lasy Phatofrint [X

e Pages

i i r——

1) »

Click to print
Printing begins.

Select the
paper size
and type

Select the
layout

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet. In the [Advanced] tab sheet, select [Enable
ICC profile] in [Color correction for printing] and print using the
[Perceptual] setting (p.118).

¥

-@> Advantages of printing using EPP EX

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).

)
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Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint (hereinafter,
“EPP"):

Simple printing of RAW images

Printing with faithful colors

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.6 or
later on your computer.

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint].

In the EPP window, select the [File] menu »
[Preferences].

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

EPP starts up.

Preferences E|
| Print | Advanced
[[] Spool print job page by page
Mumber of copies : .\1 3 Copies
Frinting Order : B_y I_Z)a!e__ v
Armount of extenzion of borderless printing : | Defaul v|
Print Quality : u.alit_',‘ F'ri-:-rit_',‘ — SeleCt
Quality
Priority
Defaults
[
0F. l [ Cancel ] [ Help ]
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Select the [Advanced] tab sheet and check that the

EPP image compensation function is disabled.

@ If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences \£|
| Frint Advanced
—— _ If checked,

Image [Cloptirmize: images automatically

Apply Fotate/Trimming to the same images in the same manner C“Ck tO

when landscape images are rotated depending on the selected lapout : remove the

(%) Rotate Left
: check mark
) Ratate Right

L apnut [ Ahways tirn when you select the layout with the marging

Set marging to the minimurn when pou select the layout with the marging

Frint filenarne when you select the index in layout

Preview all layouts of A4 and Letter
Image Select images from multiple folders
Selection .

Click to
close the
window
Y
[L a8 J ' Cancel Help

Specify the number of sheets to be printed, and then

St fhe rumber of Cope oo
{ PN .. - [t e
“PhotoPrint ey

Paper Soa : 4utin 10x1%cm Meda Trpe : Mhoto Pager Pro

15 Pep(il

—Click to
increase the
number of
sheets to be
printed

Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

Click

Select the
paper type

FranPupesPun G ProsPios  Mats Photo P
By

Click to print

Select the layout

=» Printing begins.
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.74) to
[Perceptual] (p.118) and print.

A/

Q> Advantages of printing using EPP

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP,
allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).

Printing Photographs with a Printer other than the Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.
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Organizing Images

This section explains how to delete unwanted images, create folders for : :
saving images, move or copy images, etc., and organize your images. Creatmg a Folder for Savi ng Imag €s

Introduction

You can create a folder for sorting images. Contents at

. a Glance
Deleting an Unwanted Image In the folder area, select the location where the new
Be aware that you cannot recover deleted images. folder is to be created.
Basic
1" Digital Photo Professional - [C:\Documents and Settingsicanoniby Documen Op eratl on

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Folder

@ Desktop
i Advanced
llﬂ---é MvNe‘twurP\ates Image Ed|t|ng
- and Printing
") Select the [File] menu » [Create new folder].
“ Processing
Large Numbers
of Images
Editing
JPEG/TIFF
Images
[ ] Reference
Index
The [Confirm File Delete] dialog box appears.
Click the [Yes] button. @ @
The image is moved to the [Recycle Bin] and is deleted from DPP. _
The images are deleted completely from your computer when the The [Create new folder] dialog box appears. @
[Empty Recycle Bin] operation is performed on the [Recycle Bin] Enter a folder name and click the [OK] button.
on the desktop. The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

1" Digital Photo Professional - [C:\Documents and Settingsicanoniy Documen|

fle Edt Wew Bookmark Adjustment Tooks Window Help

Falder | Callection ()

& Deshtop
= (L) My Documents

Ay Music ~
=12 My Pictures &

= ) Phota

Q
My Computer
&J My Network Places
{2 Travel

IMG_0001.CR2 : . IMG_0002.C|

The images are moved or copied to the destination folder.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

1" Digital Photo Professional - [C:Wocuments and SettingsicanoniMy Documen

File Edt View Bookmark Adjustment Tools Window Help

Folder | Callection (@) |

(& Desktop

= (L) My Documents

=~

My Computer
«

IMG_DDD1.CR2 ) IMG_D0D2.T

2]

=» The folders are moved or copied to the destination folder.
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Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

i Digjtal Photo Professional - [C:\Documents and Settingsicanoniby Documen

Eile Edit Wiew Bookmark Adjustment Toaols window Help

Folder Caollection (0)

Deskiop
=] B My Documents

=) My Music
a My Pictures

® JMBY S o Select

-8 My Network Placss
-3 Travel

]

MG _0001.CF2 IMG_0002 |

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Performing Automatic Dust Erasure Processing _____ 61
dust erasure processing, various printing functions for printing out work, ;
cust eras marr:agementgare explaiF:]ed hgre, eared © tF:]e usgr . Compat.lble Cameras............... ..... s s 61 Cg,gle;ntgeat
competent in the handling of third-party image editing software. Automatic Dust Erasure Processing in the Main Window... 62
Manually Erasing Dust (Repair Function)................ 63
Adjusting While Comparing with the Original Image... 49 Erasing Unwanted Parts of an Image (Copy Stamp - E
Changing How the Window is Split.............ccccvveeee.n. 49 FUNCLION).....eiiiiiiiieeecc e 65
Adjusting by Comparing Multiple Images................. 50 Transferring a RAW Image to Photoshop................ 65 Advanced
Displaying an Area Beyond the Set Range as a Setting Work Color Space .........cccoeveevviieeciiieeeeenn. 65 i
Warning Indicator (Highlight/Shadow Warning) ....... ol Printing with Shooting Information.................coc...... 66 T
Performing Advanced Editing............ccccccooeiiinnnnne, 52 Printing a Thumbnail List (Contact Sheet Printing).. 67 Igna(g;gtiit%g
Adjusting White Balance with Color Temperature ..... 52 Printing RAW Images on a High-End Canon Printer.. 68
Tuning White Balance with Color Wheel ................... 52 Printing with a High-End Canon Inkjet Printer ............ 68 Laprzgoecﬁjriitr)]grs
Adj:usting .Dynamic Ran.ge ......................................... 53 Printing with a Large-Format Canon Printer .............. 69 of Images
_Lszmg a Plcture. Style File.......ovviiiiiiiiiii v 53 SPECHYING PrETEIENCES....ooooooooooooooooooooooooeoeooo 20 i
one Curve AdUSIMENt.......cccmurrmreeeess B v o4 General SEtiNGS......cvvveeeeeeeeeeeeeeeee e 70 | JFEC/TIEE
Example of a Tone Curve Operation ...........w..... °F VIEW SEttNGS..oviiiieieeeeei e 72 —
About the RGB Tool Palelte .......................... Wy 2 TOOI Palette .....vuiiiiieee 73
RedUCING NOISE ..., 6 Color Management...........ccceoveeeeeeeeeeeeeeeeeee e, 74 Reference
Correcting Lens Aberration .........cccooeevveviiiiiieveeennnnnn. 57
Compatible Cameras............ccccocviiiiiiiiiii, 57 Index
About EOS 5D Compatible Lenses ............ccccceeeen. 57
About EOS 30D Compatible Lenses ..................... o7
Compatible LENSES....cccoeeeieiiiiiiii 58 @ @
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.

Select the [View] menu » [Change up/down/left/right] » [Up/
downl].

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] » [Split single image].

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

=» One image is divided and displayed on the left and right or top
and bottom.

© To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.

Ad ced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index




)

Adjusting by Comparing Multiple Images

Introduction

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
T _ _ _ windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows. Cg’g.e;rfiea‘
compared. To cancel synchronization, select the [Window] menu »
. . Synchronize] again.
Align the images. [Sy 'ze] agal Basic
Select the [Window] menu » [Arrange vertically] or [Arrange Operation

horizontally].
The edit windows are aligned.

Advanced
Select the [Window] menu » [Synchronize]. Operation
Enlarge the image. | Ad\%(j:_eq
mag iting
Enlarge and dlsplay ny of the edit windows. and Mhting

Processing
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of Images

Editing
JPEGI/TIFF
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The other edit windows will also be displayed in the same

position/enlargement ratio. @ @

|§| Synchronization only applies to the enlargement display position @
and the enlargement ratio. Adjustments to the images are not
synchronized.

.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the

Introduction

image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Contlents 2l
in red and the shaded part in blue. [Shadow]. aGlance
On the opened image, if there is an area that exceeds the value
Select the [Tools] menu P [Preferences]. entered in step 3, the highlighted part of that area is displayed in Basic
red and the shaded part is displayed in blue. Operation

Select the [View settings] tab sheet.

Advanced
Enter the warning value for [Highlight] and [Shadow]. S R
General seftings Wigw settings Tool palette Color management Ad Ced
Grid pitch |mag\3jltlng
64 Pixals{8-256) and nting
Image selection status
[“lImages opened in Editwindow remain selected in main window Process| ng
Large Numbers
Magnification in Edit windau Of Im ag es
() Fitto window QOs0% O100% O 200%
Magnification when the EdiEditimace window is double-clicked ‘ Ed|t|ng
O50% ®100% O 200% JPEG/TIFF
| Images
RAYY and JPEG
Display only CRZ images for CR2 and JPEG files of the same name
Sort order in main windm
[IRetain sort arder Reference
Highlightishadow warning
Highlight 255 32.258) .
Shadow 1 w . Index
Guick check tool display
) 50% () 100% (moiré reduction off)
Click the [OK] button to close the window. @

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens] tool palette
are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

R&W | RGE || NRALens

Brightness adjustment

1

B

0.0

White balance adjustment

s

A | Register...

I:I:: olor ternperature hd
5200 |k ff— Display the value of the
‘ setting

Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

Yhite balance fine adjustment

0

IH

Cancel

Colar tane: 0o

— Enter the values to set

Color saturation:| | g -

Drag

@ To register adjustment results as personal white balance (p.79),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

|§| The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction

Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Using a Picture Style File

A Picture Style file is an extended function of a Picture Style.
With DPP, you can apply to RAW images Picture Style files that you

Contents at

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.

a Glance
have downloaded from Canon’s web site effective for various scenes or
= - "I Picture Style files created with “Picture Style Editor”. When using a
icture Style X X i
Picture Style file, save it to your computer beforehand. A
Standard v Browse... | asic
Move downwards Operation
; Output highlight points Display the image to which the Picture Style file is to
§ be applied in the edit window (p.11).
—H Move to the left or rignt _ édvant(_:ed
Input highlight points Select the [RAW] tab sheet in the tool palette, and peTation
click the [Browse] button.
100 -0 -p 0 -4 - L0 20T 4.0 Ad\a(;ed
i lotne Seie St et S 2 ek : Imag iting
Contrast (0) and ntin
_ Move upwards :] .
It Output shadow points :
Calor tone:(d) J L;E;Oecﬁjrﬂggrs
Color saturation:¢0) 1 of Images
Sharphess:i0) J Editing
Move to the left or right JTnESg/;E: =
Input shadow points
The [Open] dialog box appears.
Trt:e ho::]zontaf[l a>:ils shlows the input level and the vertical axis Select a Picture Style file saved on your computer, Reference
SHOWS fhe OUIpULfevel. and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from Index
step 2 again.

00
©
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.117).

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
Rea | RGE | NR/Lens |
Tone curve assist @ | E+] Eb"I
Tone curve adjustment ) H
(R](5] Pl

255

& Cupve
Skraight

Right-click with the
mouse inside the graph
to display the menu

& RGERGE
Luminance R G B

o =
Brighthess: - I D
Contrast 11 = D
Hue: 5 I ﬂ._ﬂ_;|
Saturation: 1] ﬂ@]
Sharpness: 0 ﬂi_ﬂ_tl

Make adjustments.

R | RGE | NR/Lens I
Tone curve assist | ] E‘bﬂl
Tone curve adjustment = ”

ree_(RJ(&) 2|
255 | | Adjusts each channel

Batch adjusts RGB

Click to add a [[] (point)
Adjust by dragging []

Brightness: = = E‘_—l
Contrast: - I !EJ
Hue: gl ﬂEl
Saturation: Is B[00 |
Sharpness: uj g@'__|

The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[]] is 8.

To delete a [[], either press the <Del> key or double-click on the [].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.73).

)
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Example of a Tone Curve Operation

Makes medium tones brighter

Makes tones harder

Makes medium tones darker

Makes tones softer

About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore we recommend for functions other than tone
curve adjustment and automatic adjustment (p.30), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens] tool palette (p.108) when
reducing noise (p.56) and correcting aberration (p.57) after you have
made any required adjustments with the [RAW] and [RGB] tool palettes.
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Reducing Noise .
Introduction
You can reduce noise that arises in RAW images that have been shot at Click the [Apply NR] button.
night or with a high ISO speed. Noise reduction is applied to the image and the image is
NR is an abbreviation for “noise reduction”. -
redisplayed. Contents at
Display the image in the [100% view] or [200% view] aGlance
Select the [NR/Lens] tab sheet from the tool palette play gel _ -
in the edit window or edit image window. You can check the noise reduction effect. B
In the [50% view] or [Fit to window] display, it may be difficult to Basic
Adjust an image. check the noise reduction effect. Operation
Ray | RGE | MRILens
| Moise reduction | Advanced
BAWY N _ _ Operation
Lurninance noise reduction:(d) ) ) ? Additional information
O Drag the sliders right
. The noise reduction function does not work AdVERced
2 i Noise reduction cannot be applied when [Viewing and saving RAW Imag\%i_ting
Chrominanice noise reduction:(0) images] (p.70) is set to [High speed] in the [Preferences] window. and #nting
' 3 | Select [High quality] to reduce noise.
; ; ; Processing
0 10 ® T(_) chec!< the noise reduction effect, enlarge the image and Large Numbers
display it of Images
HepardEes Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the Editing
noise reduction. JPEG/TIFF
® Luminance noise reduction is not available for SRAW images Images
You can only reduce chrominance noise for sSRAW images. You
cannot reduce luminance noise.
Reference
Lens aberration correction Tune... ‘I
e o |§| If [Luminance noise reduction] has been set, resolution may be
sripnera Hminaten reduced along with reduction of noise.
Distortion OFF If [Chrominance noise reduction] has been set, color bleeding Index
BT Gics may occur along with reductlop of n0|§e. . ' -
You can set the batch processing settings for noise reduction
Cioliy iy IR using [Default noise reduction settings] in the [Tool palette] tab
_ _ o sheet in Preferences (p.73). This is particularly useful for applying @ @
You can set a noise reduction level from within a range of 0 to 10. noise reduction to all the images in a folder at once, such as
The larger the setting, the larger the noise reduction effect. batch noise reduction for images with high ISO speeds. However,
where images have a recipe attached, the noise level recorded in

the recipe is applied.

For a list of tool palette functions, refer to p.108. c6



Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which you have
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark IlI EOS-1D Mark Il N
EOS-1Ds Mark Il EOS-1D Mark I EOS-1Ds

EOS-1D EOS 5D EOS 40D

EOS 30D EOS DIGITAL REBEL EOS DIGITAL REBEL

XSi/450D XTi/400D DIGITAL

About EOS 5D Compatible Lenses

For images shot with the EOS 5D whose firmware version has been
changed to 1.1.1, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.1.0 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.5 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM EF 16-35mm f/2.8L Il USM
EF 70-200mm f/4L IS USM —

Lenses not compatible with firmware version 1.1.0
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 16-35mm f/2.8L Il USM EF 70-200mm f/4L IS USM

About EOS 30D Compatible Lenses

For images shot with the EOS 30D whose firmware version has been
changed to 1.0.6, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.0.5 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.4 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM EF 16-35mm f/2.8L Il USM
EF 70-200mm f/4L IS USM EF-S 18-55mm f/3.5-5.6 IS
EF-S 55-250mm /4-5.6 IS —

Lenses not compatible with firmware version 1.0.5
EF 14mm f/2.8L Il USM EF 16-35mm /2.8L Il USM
EF-S 18-55mm /3.5-5.6 IS EF-S 55-250mm /4-5.6 1S
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Compatible Lenses

EF 14mm f/2.8L USM
EF 14mm f/2.8L Il USM
EF 20mm f/2.8 USM
EF 24mm f/1.4L USM
EF 28mm /1.8 USM
EF 35mm f/1.4L USM
EF 50mm f/1.2L USM
EF 50mm f/1.4 USM
EF 85mm f/1.2L USM
EF 85mm f/1.2L Il USM
EF 100mm /2.8 Macro USM
EF 135mm f/2L USM

EF 180mm f/3.5L Macro USM

EF 200mm /2.8L USM

EF 200mm f/2.8L Il USM
EF 16-35mm f/2.8L USM
EF 16-35mm f/2.8L Il USM
EF 17-35mm f/2.8L USM
EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM
EF 24-105mm f/4L IS USM

EF 28-70mm f/2.8L USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6

EF 28-200mm f/3.5-5.6 USM

EF 28-300mm f/3.5-5.6L IS USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/4L USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L IS USM

EF 100-400mm f/4.5-5.6L IS USM
EF-S 60mm /2.8 Macro USM
EF-S 10-22mm f/3.5-4.5 USM
EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 USM
EF-S 18-55mm f/3.5-5.6

EF-S 18-55mm f/3.5-5.6 |l

EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm /3.5-5.6 IS
EF-S 55-250mm f/4-5.6 IS

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Distortions
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)

In the tool palette, select the [NR/Lens] tab sheet.

Click the [Tune] button.

Rawi | RGE | MRLens
[Moise reduction |
ReAN
Luminance noise reduction:(0}
J
1] 10
Chrominance naoise reduction {0}
J
1] 10
TIFF or JPEG
Apply MR
Lens aherration correction l Tune... II
Feripheral illumination OFF
Distortion OFF
Chromatic aherration OFF
Color blur OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

"' Lens aberration correction - [IMG_1001.€R2]

| shocting distance infarmation
i)
w

[ Peripheral illurination

[ Distortion

[Jchromatic aberration

» The image is corrected and redisplayed.

© Check the results of corrections to peripheral illumination or

distortions in the full view.

© Check the results of corrections to chromatic aberration and color

blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.113).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [ g)¥ ] mark is displayed on the image to
indicate the lens aberration corrections (p.105).
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About Shooting Distance Information Slider

When correcting RAW images taken with the EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 40D or EOS DIGITAL REBEL XSi/450D, the slider is
set automatically according to the shooting distance information
saved to the image.

However, if EF 50mm /1.4 USM, EF 85mm f/1.2L USM or

EF 28-70mm f/2.8L USM is used, it is set automatically to the right
end at infinity position. You can then minutely adjust the distance by
operating the slider while looking at the screen if the shooting
distance is not infinite.

When correcting RAW images taken with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds, EOS-1D, EOS 5D,
EOS 30D or EOS DIGITAL REBEL XTi/400D DIGITAL, it is set
automatically to the right end at infinity position. You can then
minutely adjust the distance by operating the slider while looking at
the screen if the shooting distance is not infinite.

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by selecting [View] menu » [Tool palette]. If you perform
correction procedures (p.59) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.37).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.56).

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-29).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.27) and/or the color saturation (p.88) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]

correction is made.

@ For a list of the [Lens aberration correction] window functions, refer

to p.113.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [@1] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark IlI EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL L = o _ _

XSi/450D XTi/400D DIGITAL £ Additional information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu P [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appears. copy stamp window or performing the “Re-Editing an Image”

procedure (p.39).

® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

® Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

® The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
Dust spots are erased in a single operation. using the repair function (p.63) or the copy stamp function (p.65).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

1/ 2 C:\Dacuments and Settings\canon\by Documents\My Plctures P hotoloood o odG_0050.007 [ 34546 x 2304]
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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the dust spot is light in color, click the [ ] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].

Manually Erasing Dust (Repair Function) _
Introduction
You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and
click.
In the main window, select the image you want to r——— P —————

14 2 Cx\ocuments and Settings\canon\y Documents\y PlcturesiP hotobooo o oddWG_0050,002 [ 3456 x 2304] CO ntents at
erase dust spots. a Glance
Select the [Tools] menu » [Start Stamp tool].

The copy stamp window appears. Basic
] ) ) Operation
When the image has redrawn itself, double-click the
point from where dust is to be erased. i e Click
1/ 2 C:\Documents and Settings\canon\Wy Documents\WMy Plctures\P ho 50,007 [ 3456 x 7304] _/I I":‘; - e Advanced
P Operation
o o)
Advapced
Imag iting
and Pfinting
Double- e :
click > The dust spot within the [O] is erased. Laprgoecﬁjf;]'ggrs
@ Click on another part of the image to continue erasing dust spots of Images
in the image.
® To erase dust in another part of the image, either right-click with Editing
the mouse, or click the button clicked in step 4 again to cancel dust J'TESSL'EF

erasure processing and perform the operation again from step 3.

s o v o o When the dust spot cannot be erased, [(§)] is displayed.
The display changes to 100% view. _ Click the [OK] button to return to the main window. Reference
The display position can be changed by dragging. The [@,] mark (p.105) is displayed on an image from which dust

Click the button that matches the dust spot to be spots have been erased.

erased. Index
If the dust spot is dark in color, click the [ ] button, and if
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.65).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.39).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

\

~
-

/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.63).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.105) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.81.

ﬁl Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.117) is added. The ICC profile
contains information about [Preferences] (p.74) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.

Setting Work Color Space

A different work color space (p.118) from the default settings (p.74) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.74), this
default setting will not be applied and the individually set color space will
remain.

ALy

5@3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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)

Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print - N .
together with titles and shooting information, etc. "< To maintain the settings

Introduction

Select one image to be printed.

Select the [File] menu » [Print with detailed setting].

Specify the required settings for printing, and then
click the [Print] button.

Switches the settings tab sheet

" C:\Documents and SettingsicanoniMy Documents\My Pictures\Photobooo s sodIMG_0001.CRE FZ|

Frlnterilmage Text | Seftings

Frinter.

Canan xxxx v |

Media 278.4mm x 215.9mm
‘Leﬁer v|
i |
Media orientation
) Portrait (&) Landscape
Media type:
Flain Paper
Frint Quality
Standard
Borderless:
Off
Print profile
CHYK profile:
CMS settings

115 ' Print ' Cancel Apply

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [El] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

|§| You can set printer profiles (p.74).
If CMYK simulation has been set, the image is printed in the set
colors (p.74).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Contact Sheet Prints].

Specify the required settings for printing, and then
click the [Print] button.

Switches the settings tab sheet

I Contact sheet El
Frlnt9r|lmage Text | Seffings |

Frinter.

‘ Canon xxxx v |
Froperties

Media HME9mmx 278 4mm

Leter |

Media arientatian
(&) Porrait O Landscape

Media type:
Flain Paper

Print Quality
Standard

Borderless:
Off

Print profile

CRYK profile:

CMS settings...

' Print ' Cancel Apply

Print preview

A/

Q= To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

|§| You can set printer profiles (p.74).
If CMYK simulation has been set, the image is printed in the set
colors (p.74).

)
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your compulter.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Specify the required settings for printing, and then
print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.74) is not applied.

A/

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When the color space is set to SRGB or Adobe RGB (p.65, p.74), this
color space is automatically transmitted from DPP to Easy-PhotoPrint
Pro, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with a high-end Canon inkjet printer, the color reproduction
area widens, and green and blue in particular are reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install the
imagePROGRAF Print Plug-In for Digital Photo Professional on your
computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.70) and CMYK simulation (p.74) are not
applied.

A/

-@> Advantages of printing with the imagePROGRAF Print Plug-In

Printing with faithful colors

When a color space is set (p.65, p.74), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.65, p.74) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences _
Introduction
You can change the various functions of DPP in the Preferences :
window. Check the contents of each window and set. General Settin gs
Also, depending on the item, a detailed explanation may be available, You can specify the folder that opens when DPP is started up, image
. ; ; ; Contents at
so refer to each window. quality of displayed and saved RAW images, etc. a Glance
Select the [Tools] menu P [Preferences]. o T E3
The [Preferences] window appears. General setiings View s ettings | Tool palette Calor management Basic
. . Startup folder Operation
Select the tab sheet, specify the settings, and then ® Last isplavert ol
click the [OK] button. Qe
. Advanced
Preferences EJ Operation
General settings ‘Wiew seftings Tool palette Color management BN ISR

Display message when adding file
Startup falder ® Display o 0

() Add 1o file automatically

(&) Last displayed folder Ad ced
Specified folder iti
21 | Yiewing and saving RAVW images Imag |_t|ng
(&) High guality (recammended) Viewisave RAW images at high quality an d nt' n g
. . : . Moiré is reduced and the MR tool palette can be used
View images at high speed {maoiré
Save recipe reduction off)
(&) Display message when adding file (O High speed ProceSS|ng
) Add to file automatically Large Numbers
| JPEG image quality of Images
Yiewing and saving RAW images [ Remove block noise and mosguito noise
(&) High quality (recommended) Wiewdsave RAW images at high quality | [[] Display thurmbnails at high guality T
. Mairé is reduced and the MR tool palette can be used Editin
D\newn_"nages athigh speed (moiré
reduction off Defaultvalue of output resolution JPEGI/TIFF
() High speed Men |mages

| dpi(1-60000)

At EQS Utility startup

[[] Edit image window enahled at EOS Utility startup
[[] Display thurmbnails at high quality Reference

JPEG imade guality ‘
[]Remave block noise and mosguito noise

Default value of output resaolution

330 dpii1-60000)

ALEDS Utility startup [ [o]%4 I[ Cancel |ndeX

[]Editimage window enabled at EQS Ltility startup
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.56) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.56)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]

If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied.
As the [View images at high speed (moiré reduction off)] setting is the
same as [High quality] other than for display of the image, the image
undergoes false color reduction processing when it is saved and the
noise reduction function is also available.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window in
the [100% view] or [200% view] enlargement display, and the time it
takes to save a RAW image is less than in [High quality].
You cannot use the noise reduction function (p.56).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

? What is the difference between the [High quality] and [High
speed] displays?

The display image quality of [High quality] and [High speed] is the same
except when the image is displayed in the [100% view] or [200% view]
enlargement display in the edit window or the edit image window.

» JPEG image quality

[Remove block noise and mosquito noise]

? You can improve the quality of a JPEG image by reducing the noise
that is likely to occur when RAW images are converted to JPEG
images and saved (p.38, p.80).

This setting is also effective for JPEG images that have been saved
with a different name.

[Display thumbnails at high quality]
You can have the thumbnails for JPEG images automatically displayed
at high quality. If you checkmark [Display thumbnails at high quality],
all subsequent JPEG image thumbnails imported into DPP will be
displayed at high quality.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.38, p.80).
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Introduction

Ty— Settings Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.19).

You can specify settings relating to the display. Contents at
ontents a

If you checkmark the checkbox, the order of the rearranged images is a Glance
Preferences (X maintained even if you exit DPP or select another folder in the folder
General settings View seftings | Tool palette Color management area.
Coinler If you remove the check mark, the order of the rearranged images is not - Basi((?
B Phes@2st maintained and reverts to the previous order when you exit DPP or peration
| _ select another folder in the folder area.
mage selection status
[¥]Images opened in Editwindow remain selected in main window Advanced
Operation
Magnification in Edit window: . - -
(%) Fitto window ) 50% 100% O 200% nghllght/ShadOW Warnlng
Highlighted/shaded areas that exceed the set range can be displayed AdvERced
Magnification when the EditEdit image window is double-clicked on the image as Warning indicators (p5l) Ima itin
O 50% =100% O 200% an(? ntingg
RAW and JPEG
[¥] Display only CR2 images for CR2 and JPEG files of the same name Processi ng
Large Numbers
Sort arder in main window ‘ Of Images
[[]Retain sart arder ‘
Editing
Highlight'shadow warning JPEG/T”:F
Highlight 255 S . Images
Shadow 0 {154y . ‘
Guick check tool display
® 50% (100% {mairé reduction off) ‘ Reference
f K [ cancel |
Index
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Tool Palette

You can specify settings for the tool palette.

Preferences @

General settings Wiew settings Tool palette Color management

Default settings of RGE tool palette

Tone curve mode Tone cure interpolation method
(RGBRGH (® Curve
) Luminance R G B () Straight

Histogram display
() Before adjustment
() After adjustment

Taool palette display in Edit Image Window
(&) Docking display

() Floating display

Modified Picture Style setlings
[] Retain settings of each Piclure Style

Tool palette digplay mode

[]5ame for Main window and Edit window |

Cefault noise reduction settings

RAW luminance noise reduction: {0) J

0 10
RAW chrominance noise reduction: (0) ;

0 10
TIFFIPEG chrominance naise reduction: (0} ';

[_ox [ cancel |

Default settings of RGB tool palette
You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast]

and [Sharpness] settings will be changed or retained, when you change

the Picture Style.

© If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.

® If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level. Further,
for images not having a recipe attached, the default set here for noise
reduction level is applied. However, for images with a recipe attached,
the noise level recorded in the recipe remains as it is and the default for
noise reduction level set here is not applied.

=)= Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP. This eliminates the need to
apply noise reduction to each individual image.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

General settings iew settings Tool palette Color management
Cefault settings of YWork color space

) sRGB O Apple RGB

() Adobe RGB () ColorMatch RGB

C)wide Gamut RGE

Calor matching settings

For display

& sRGAE

) Moniter profile

Frinting profile
--- Mane - “

CHYK simulation profile ‘
— Maone — w ‘

Rendering intents when using Eagy-FhatoPrint
() Perceptual

(¥ Relative Colorimetric ‘

[ OK [ cancel

Default settings of Work color space

You can select from five types of color space (p.118) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.38,
p.80) or printed (p.39, p.42, p.44, p.66 to p.69).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the edit
window (p.106) and the edit image window (p.110).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.65).

® Display setting (color setting of the monitor)

Where a profile (p.117) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you checkmark [Use the OS settings], the color profile set in
Windows will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Checkmark the [Monitor profile], click the [Browse] button and in the
dialog box that appears, select a profile for your monitor.

5@5 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.117) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.44, p.66, p.67) except for printing using a Canon inkjet
printer (p.39, p.42) or linked printing (p.68, p.69).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

A/

5@3 Automatic settings for printing using EPP EX, EPP, and linked
printing

If you are printing using a Canon inkjet printer (p.39, p.42) or using
linked printing (p.68, p.69), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.118) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.103, p.106,
p.110) in the bottom of the main window, edit window and edit image
window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.118) for printing
using Easy-PhotoPrint (p.42).

The rendering intent is ordinarily set to [Relative Colorimetric].

» When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

Introduction
For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
Contents at
here. a Glance
Utilizing Adjustment Contents (Recipe)................... 77 R
Saving Recipes as a File.......ccccoovevveiiiiiiiiiii e, 78 Operation
Loading and Pasting ReCIPeS..........cccevvvvvviiiieeeeeeennnns 78
Copying a Recipe and Applying to Another Image..... 78 Advanced
. ) Operation
Batch Apply White Balance to Images (Personal White
Balan(?e) O IR VIR e, 79 Adionoed
Registering Personal White Balance.......................... 79 |Image Editing
. \ and Printing
Applying Personal White Balance .............cccccceeeeeen. 79 —
Batch Save as JPEG or TIFF Images (Batch Lg’rréocsiggrs
PrOCESSING)...uu i iciiiiiie e 80 of Iméges
Batch Transfer Images to Image Editing Software.. 81 E—
Batch Change the File Name of Images.................. 82 J'Tn'ﬁgéL'SFF
Changing the File Name of Images in the Order in the
MaiN WINAOW .......coveiiiiiiiiiiiiiiiiieeeee e eeeeeee e 82
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

i|PEB | NR/Lens
Brightness adjustment m

&

3 0.00

y

‘White halance adjustment
Vol
v

Shat zettings

Ficture Stvle

Standard “ Browse

14

00 -80 -60 -40 -20 00 20 4.0

Contrast: (0) J
[Linear

Calar tane:{) i |

Color saturation:{0) I

Sharpnessi{1) i

RAW image data

I \N
Lyrd

Contents adjusted using the tool
palette can be handled
individually as a recicpe file

>

(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images can be saved as
a recipe file (extension “.vrd”) and loaded and applied to another
image in the same way as with RAW images (p.84, p.99).

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens]). For this reason, other editing content such as
trimming or dust-erasure (copy stamp) is not included in the recipe
data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Crzgrer
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be_ applied ’8‘3‘{3?2352
o _ , and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
T : selected image].

and check the settings in the tool palette. When only a few settings are - : . Advanced
adjusted, we recommend you use a file name that describes the Jherecipejis appliedito the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which arecipe is to be copied

a Glance

Proceflsing
Largbers
of Im@ges
Loading and Pasting Recipes —
iting
Select the image to which arecipe is to be applied, JPEG/TIFF
. Images
and then select the [Edit] menu P [Read and paste
recipe from file].
The [Open] dialog box appears. Reference
Select arecipe and click the [Open] button.
The recipe is applied to the image.
Index

00
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance

Adjust the white balance (p.25, p.26, p.52).
To adjust white balance, select a setting other than [Shot
settings] from the [White balance adjustment] list box (p.25). You
will be unable to register the adjustments if you select [Shot
settings].

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personalwhite balance

Register current setting in personal white balance

Current setting:  Click white halance

1 w || Clickwhite balance

Cancel ]

| import.. || Export. | |[0K

? To use the registered personal white balance on another
computer

In step 3, click the [Export] button to write as a file.

Copy the file to another computer.

In DPP on the other computer, display the window of step 3.

Click the [Import] button and in the window that appears, select the
copied file.

Applying Personal White Balance

In the main window, select the image to which white
balance is to be applied.

Click the [Tool] button on the toolbar.
The tool palette appears.

Click the personal white balance number button that
Is to be applied.

RAW | RGR | MR/Lens|

Brighthess adjustment =) ﬂ
i e . 0.00
White balance adjustment =) ﬂl
A ! [ l Register...
EavligF v | Tune.
Picture Style =) ﬂ'

Etandard - Browsea...
i Ei . : . . :

Los | i i i i
-100 -80 -60 -40 -20 00 20 40

Contrast: (0}

[Linear
Color tone: {0y B
Colar saturation:{) I
Sharpness:il) L]

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing) .
You can batch convert and save edited RAW images to highly versatile In the processing dialog box, click the [Exit] button.
JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain
unaffected. Cg'gﬁi”rf(s: eat
In the main window, select multiple images to be
converted. o Basitc
peration
Click the [Batch process] button on the toolbar (p.103).
The [Batch settings] window appears.
] ) ) _ Advanced
Specify the required settings, and then click the Operation
[Execute] button.
Batch settings @I Advan Ced
IMG_0001.CR2 Save folder Image Editing
mgzgggéggé CADocuments and Setiingsicanonity Documentst ? [Save] cannot be performEd and Printing
IMG_0004.CR2 . 5
MO 0005 o2 e In the [Batch settings] window, you cannot perform [Save] or [Save As]
000 o3 it e * 37, p.98) to edited RAW i Procogsing
— — (p.37,p.98) to edite images.
IMG_0010.CR2 Larg bers
MoT0012 R outputseting of ImBiges
IMG_0013.CR2 utput resalution | 340 i [¥]Embed ICC profile L i 4
e . " ' Q< skillful batch saving =
esize . . . . . . 3 I lng
. © While saving is being performed, you can continue working in JPEG/TIFF
another window Images
Since the saving function operates independently in the background,
File name you can continue with an operation in another window such as the
S main window or the edit window during the saving process. Reference
P — To convert all images and save, do not select an image in the
Sing Sequence number main window
S ”gﬁmsequemwmw If you do not perform step 1 and perform step 2 with no image Index
S e selected in the main window, all the images displayed in the main
window will be converted and saved. [
Image transfer settings
ﬁl If you have selected [New file name] in [File name], [Sequence @ @
[ Convert RAW images only I[ Execute ]l Cancel ] number] has to be set
- “ By saving as explained on this page, a trimmed image (p.35,
The processing dialog box appears and saving begins. p.92) or dust-erased image (p.61 to p.65, p.94 to p.98) actually
When all the images are saved, the [Exit] button appears in the becomes a trimmed image or dust-erased image.
processing dialog box. For a list of [Batch settings] window functions, refer to p.115.
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Batch Transfer Images to Image Editing Software _
Introduction
You can transfer multiple images to image editing software. The Select Photoshop CS.
software used here as an example is Adobe Photoshop CS. In the [Open] dialog box, select a Photoshop CS file or a shortcut
_ _ _ _ and click the [Open] button. Contents at
In the main window, select multiple images to be The [Open] dialog box closes and [Image transfer settings] in the a Glance
transferred. [Batch settings] window is set to Photoshop CS.
Click the [Batch process] button on the toolbar Checkmark [Open image using software]. Basic
(p.103). Operation
The [Batch settings] window appears. O
Perform settings required for transferring (e.g. file Advanced
format). Operation
Click the [Browse] button. T ——
Batch settings @| CIICk the [Execute] button. Imadg%EC““ng
IMG_0001.CR2 Gave folder 4 i 1 i an rmtlng
ot o o Sty oo <+ The Bigcessing dialog box appears and batch transfer begins.
MG 0004 CR3 =»When the first image has been transferred, Photoshop CS starts
IMG_0005.CR2 Pl e f di displ di f d ord Procefsing
IMo_0007 G kand ortie ExtJPEG 3 up and transferred images are displayed in transferred order. Larg bers
01 CF2 image aualty i of Iméges
IMG_0011.CR2
IMG_0012.CR2 ELIBIEE T
mg:gg}igs% Output resolution | 350 gpi [ZIEmbed GG profi Ed|t|ng
IMG_0014.CR2 Resize sefling JPEG/T”:F
[ Resize Images
File name Reference
) Current file name
(%) Mew file name
5;!’;:3_ BDZE;I;IEHCE number |ndex
[[]&ave sequence number
Ex: DPFP_0001.PG, DPP_000Z2.JPG
Image transfer settings @ @
@

The [Open] dialog box appears.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]

" C:\Dpcuments and SettingsicanoniMy DocumentsiMy PicturesiPhotobooo oc sod
File narne Extension
OPP + | Bhooting DateiTime + || Beguence number v Do notchange v
Basic Settings Format settings
Sort Sequence number
) Fitto main window 0001 | [] Save sequence number
) File name

Shaoting DateTime
() SBhooting DatelTime

Wear Month Day v
-hid-DD v
[Icopy Rename
Insert underhar
Original File Marme Modified File Name
IMG_0001.CR2 ~ DPP_06-09-13_0001.CR2 A
IMG_0002.CR2 DPP_06-08-13_0002.CR2
IMG_0003.CR2 DPP_06-08-13_0003.CR2 ”
IMG_0004.CR2 DPP_06-09-12_0004.CR2
IMG_0005.CR2 DPP_06-08-13_0005.CR2 =
ING_0008.CR2 DPP_06-08-13_0006.CR2
IMG_0007.CR2 =t DPP_06-09-12_0007.CR2
IMG_0003.CR2 DPP_06-08-12_0003.CR2 1=
InG_0003.CR2 DPP_06-08-12_0003.CR2
IMG_0010.CR2 DPP_06-09-12_0010.CR2
IMG_0011.CR2 - DPP_06-08-12_0011.CR2

-4
' Execute l Cancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur.

|§| You cannot start up the rename tool from the [Collection] window
(p.33, p.104).
For a list of the rename window functions, refer to p.116.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window (p.19),
you can change in one operation the names of the files for the images,
in the order they were rearranged.

Change the order of the images in the main window
(p-19).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

.r
C:\Documents and Settingsicanonyy Doy

File name

| DPF w | Shooting Dates]

Basic Settings

Sart

(@ Fit to main Windnw]
I File name
i) Shooting Date/Time

Specify the required settings (p.116).
To copy an image, checkmark [Copy Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgstle;r;cgeat
Editing JPEG and TIFF Images...........ccceevvvieeeeeeenn. 84 R
About the RGB Tool Palette ........ccccoeeeeeeeiiiiiiiieeeeeenn. 84 Operation
Automatically Adjusting Brightness and Color (Tone
CUINVE ASSISE) ... 85 Advanced
Adjusting Brightness and Contrast................ccceuve.... 86 S R
Adjusting Color Tone Using Click White Balance....... 87
Adjusting Hue, Saturation and Sharpness.................. 88 ,m':‘;‘éaggﬁ?ng
Tone Curve AdjUStMEeNt...........cc.coveveeveeereeeeereeeeeea 89 | and Printing
Adjusting Dynamic Range ..........ccccooevviviiiiiiiiiiinnneeenn. 90 m
RedUCING NOISE .....ceveveiveeeecie e, 91 Laggfe"':ggggrs
TrmMmMING an IMage......cccoovveeeiviiiieiiiceeeiee e 92
Performing Automatic Dust Erasure Processing ..... 94 JPE’§PFF
Compatible Cameras............cccceeeeeeeeeeiiieeeeeeceenn, 94 Imees
Automatic Dust Erasure Processing in the Main
WINAOW ...eiiic e 95 Reference
Manually Erasing Dust (Repair Function)................ 96
Erasing Unwanted Parts of an Image (Copy Stamp
T T (1o 1) R SRPOTN 98 Index
Saving Editing Results............ccccceei i, 98
Saving Editing Content to an Image................c.......... 98 @ @
Saving as a Separate Image .............cccceevvvvvvveeeeeennn, 99
Applying Editing Contents to Another Image........... 99 @
PHNTING ..o 99
Re-Editing an Image.........ccoeiiiiiiiiiiiieeeeiieeeeeeeee 99 83



Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any nhumber of
times.

Réw | RGE | NR/Lens )
O] @

Tone curve assist i)
Tone curve adjustment =
(R[] Pk

255

S S

™ JPEG, TIFF imag

i MY
-
5 vrd )
Brightness: i [g —

Contrast 5| n

. Contents adjusted using the tool
Hue: 3 o

palette can be handled
Saturation: : 3 o100 | individually as a recicpe file
Sharpness oo ||| (extension “.vrd”) (p.77, p.99).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.98), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.77, p.99).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.89) and
automatic adjustment (p.85), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

RAw | RGE | NRALens

Tane curve assist @] Eh P} Reverts the tone curve

Tone curve adjustment - | to the original settings
(_ree J[R](c] 2]

255 | High

Standard

Brightness: | 0
Contrast: N 0
Hue: 0 E _Ij j
Saturation: | ﬂ1 il
Sharpness: | ﬂ 0

The tone curve changes as adjusted.

@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [[ ] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.88).
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Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted.

RaWw | RGE | MR/lens

Tone cure assist
Tone curve adjustment =) ”
[ ree J[R](c) Pl

255

Brighthiess: —w—
Contrast:

Hue: —J—
Saturation: ————
Sharphess: I

|

Drag the sliders left or
right
Enter numerical values

Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.
Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Contrast:

|§| The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images

E g
JP IFF
| es

Reference

Index

00
©

86



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[#]] button.
F{F';'u'l.l'.l RGE |.NRJI|_lEﬂS I

Tone curve assist

Tone curve adjustment

C_ree J[R](c] (8]

255

o |
o]
Brightness: —_— EI
Contrast: ——— 1 EI
Hue: —— ED
Saturation: ——— E
Sharpness: 0 ED

Click on a point that is to be the standard for white.

1" Digital Photo Professional - [C:\Documents and SettingsicanoniMy Documents\y Pic ... |ZHE|E|
File Edit Wiew Adjustment Tools Window Help

(1595, A30) 230,223,236  High quality  Adohe RGE/SRGA

|
The coordinates of the cursor position and
the RGB values (8-bit conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.

@ If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, right-click with the mouse or click

the [[_# ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).

)
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Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall
atmosphere of an image harder or softer.

RAw | RGE | NRALens |

Tone curve assist O | ] Eb”
Tone curve adjustment =) ”
([ reBJ[RJ(c) Pl

=

Brightness:
Contrast:
Hue:

Saturation:

Sharpness:

% Enter numerical values

Drag the sliders left or right

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones

redder.

Saturation: Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
harder, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% viewl]. If the view is set to [Fit to window] (full view), the

sharpness will seem unnatural.

ﬁl The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.117).

Select the tone curve mode and interpolation
method.

RAW | RGE | NR/Lens |

Tone curve assist 0| 2] IZ?b"I
Tone cune adjustment ) H
(r)(c) Pl
255 |
o Curve
Straight . . .
Right-click with the
® RGER G E f ol
) mouse inside the graph
Luminance . B A
to display the menu

o

__l_ S
o] 255
Brightness: = ig o
Contrast: sl | - [0 |
Hue: = ] E!_D__l
Saturation: ] 5100 ]
Sharpress: K| ﬂi_tl |

Make adjustments.

RAW | RGE [ NR/Lens I
Tone curve assist O] | 2o ﬂl
Tane curve adjustment ) H

Cres ()6 (6] |
|

255

Brightness: = ==l | :|
Contrast: = g !El ]
Hue: 3 gi_ﬂ_ |
Saturation: g EFDD [
Sharphess: ] &0 |

Adjusts each channel
Batch adjusts RGB

Click to add a [] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[], either press the <Del> key or double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.73).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.73).

)
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output highlight points

RAW | RGE | NR/Lens | |

Tone cure assist rall ey =) Hl
Tone curve adjustment b«H
reB__|(RJ(G](E] 2 |

Output 255

highlight point

numerical

value

Move to the

right

Input shadow

points

Output shadow —}o

pointnumerical o | 255

value Brighthess: | 0]
Contrast | o |

Input shadow — -

point numerical | Hue: 3 oo |

value &
Saturation: I EHDD ]
Sharpness: 0 =[5 :_EI [

Move upwards
Output shadow points

— Reverts the

image to the
original
settings

Move to the
left

Input highlight
points

{— Input highlight

pointnumerical
value

The horizontal axis shows the input level and the vertical axis shows
the output level.

The setting range of shadow points is 0 to 247 (in 1-stop
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop
increments when entering a value).

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens] tab sheet from the tool palette
in the edit window or edit image window.

Adjust an image.

O Drag the slider right

You can set a noise reduction level from within a range of 0 to 10.

The larger the setting, the larger the noise reduction effect.

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view].
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it may be difficult to
check the noise reduction effect.

? To check the noise reduction effect, enlarge the image and
display it

Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the
noise reduction.

@ If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
using [Default noise reduction settings] in the [Tool palette] tab
sheet in Preferences (p.73). This is particularly useful for applying
noise reduction to all the images in a folder at once, such as
batch noise reduction for images with high ISO speeds. However,
where images have a recipe attached, the noise level recorded in
the recipe is applied.

For a list of tool palette functions, refer to p.108.
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with
the EOS-1Ds Mark Il or EOS-1D Mark I, the trimming range based on
the aspect ratio information is displayed.

Select the image to be trimmed.

Select the [Tools] menu » [Start Trimming tool].
The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.

1715 C:\Becuments and Settings\iy Dacumentsiiy Picturesbooo o odllG_0001.CR?

—— Cancel

»— Select a
trimming
ratio

— Drag the
trimming
range

1037, S04) - (3006, BB m (138 x 1263 1.50)

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.105).

=» When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.99).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.105).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.99).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark I, the set trimming range based
on the aspect ratio information is displayed. However, since the
image is not actually trimmed, you can change the trimming range or
revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

The image is displayed in its trimmed condition.

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [8]] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark IlI EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL L = o _

XSi/450D XTi/400D DIGITAL < Additional Information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu P [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appears. copy stamp window or performing the “Re-Editing an Image”

procedure (p.99).

® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

® Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

® The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
Dust spots are erased in a single operation. using the repair function (p.96) or the copy stamp function (p.98).
The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

1/ 2 C:\Dacuments and Settings\canon\by Documents\My Plctures P hotoloood o odG_0050. 183 [ 34546 x 2304]
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and

click.
In the main window, select the image you want to

erase dust spots.

1/ 2 C:\Dacuments and Settingsicanonibly Documents Wy Plctures\P hotokooor_soc_odiG_0050. 06 [ 34546 x 2304]

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, double-click the

......

point from where dust is to be erased. (+) 1 Click

1/ 2 C:\Dacuments and Settingsicanon\hy Documents\WMy Plctures! M50, PG [ 3456 x 7304]

Double- T
click » The dust spot within the [O] is erased.
@ Click on another part of the image to continue erasing dust spots
in the image.
® To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

The display changes to 100% view.

: » _ Click the [OK] button to return to the main window.
The display position can be changed by dragging.

The [@,] mark (p.105) is displayed on an image from which dust

Click the button that matches the dust spots to be spots have been erased.
erased.

If the dust spot is dark in color, click the [ ] button, and if

the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [Q].
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.98).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.99).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

\

~
-

/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.96).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.105) is displayed on a corrected image.

Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.84 to p.91) as
well as the trimmed range (p.92) and dust-erasure (p.94 to p.98)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.84 to p.91)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.38)

Batch save as JPEG or TIFF images (batch processing) (p.80)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image =

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.37)

Utilizing adjustment contents (recipe) (p.77)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.39)

Printing with shooting information (p.66)

Printing a thumbnail list (contact sheet printing) (p.67)

Printing RAW images on a high-end Canon printer (p.68)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.84 to p.91), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.98) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

An Index is provided at the end of the chapter for you to easily find
o information you are looking for.
Troubleshooting.........ccuiiiiiiiiiiii e 101
Deleting the Software (Uninstalling) ...................... 102

List of Main Window (Folder Window) Functions .. 103
List of Main Window (Collection Window) Functions... 104
Image Frame Information in the Main Window and Edit

Image WINdOW...........ooiieiiiiiiiiieeeeeeee e 105
List of Edit Window Functions ..............ccccevveeeene., 106
List of Tool Palette Functions ................c..cccceeeeeee 107
List of Quick Check Window Functions................. 109
List of Edit Image Window Functions .................... 110
List of Convert/Save One Image Window Functions 111
List of Trimming Window Functions....................... 112
List of Lens Aberration Correction Window Functions 113
List of Copy Stamp Window Functions.................. 114
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLONS..........ccoviiiiiiiieeeceeeeeei, 115
List of Rename Window Functions........................ 116
GlOSSAIY ..ovviiieeiieee e 117
INAEX ... 119
About This Instruction Manual .............................. 123
Trademark Acknowledgments..............ccooeeeeeeen. 123
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install the software if a user setting other than [Computer
administrator] privilege or [Administrator] privilege is selected. Select
the [Computer administrator] privilege user setting in Windows Vista
and Windows XP or the [Administrator] privilege user setting in
Windows 2000. For detailed information on selecting the user setting,
refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.61 to p.65, p.94 to p.98) is displayed in
a window other than the copy stamp window, it is displayed as it was
before dust erasure was performed. Check dust-erased images in the
copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.107).

PowerShot Prol RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.107).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.23, p.103, p.109, p.110),
trimming (p.35, p.92), dust erasure (copy stamp) (p.61 to p.65, p.94 to
p.98) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.107).

Color appears weak in the image when viewed with
other software

® A RAW image which has a color space other than sRGB set (p.65,

p.74) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with SRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.74) and a profile for a printer is
set up correctly (p.74), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.39, p.42) or linked printing (p.68, p.69) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.43).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.45).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with the EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and PowerShot Prol may not display
image information (p.10, p.21).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under the Computer administrator/Administrator privileges
when uninstalling the software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [Start] button » [All Programs] ([Programs]
in Windows 2000) » [Canon Utilities] » [Digital Photo
Professional] P [Digital Photo Professional
Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
=» The software is uninstalled.
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List of Main Window (Folder Wind

Shows/hides the tool palette (p.107)
Selects all images
Cancels selection of all images Folder path

Shows/hides the folder area

Switches to the edit image
window (p.110)

Toolbar*!

)
[Collection] tab sheet*>

Select all Clear all

Falder | Caollection (3)

[Folder] tab sheet*> ‘

ow) Functions .19

Check marks (p.18)
Removes check marks (p.18)
Image rotation (90 degree units)

Batch conversion/
saving (p.80, p.81)

Rotate left Rotate right

@ Desktop

=) My Documents
=) My Music
= My Pictures

[=7) Phata

j Iy Computer

\3 Iy Metwork Places

1) Trawel

IMG_0001.CR2 IMG_0002.CR2

IMWG_Do0 CR2 25 IMGJDM.CRZ

Folder area*?

Rtd |G D002 CR2 IRAG_0009. CR2 IniG_0010.CR2

® 1_0008 . RiE & WG 0007 .CR2
R+T i R+T i
R

.
i e o Sl
) ~ IMG_O0011.CRz IMG_0012.CRz MG_00 13 CR2 B " IMG_0015.CR2
Information dlsplay*3 —|-(1929, 899) - 167,172,185 High uality Recipe data: Yes Mumber of images: 15 Nummber of selected images: 1 CMYK

Display mode**

Recipe attachment status (p.77)

*1 To switch between show/hide, select the [View] menu » [Toolbar].

*2 The images inside the folders selected here are displayed in a
thumbnail list on the right.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.

Number of selected images CMYK simulation display (p.74)
Number of displayed images

*4 The item selected in [Veiwing and saving RAW images] (p.70) of the
[Preferences] window is displayed.
*5 You can switch between the [Folder] and [Collection] windows.

)
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List of Main Window (Collection Window) Functions (=33

Shows/hides the tool palette Check marks
Selects all images Removes check marks
Switches to the edit image Cancels selection of all images Image rotation (90 degree units)
window
Toolbar. = 2 B® ® (= = RO R G B > == Batch conversion/
[C0||eCtI0n] tab Sheet a0 . Cheski Chesl? Check Rotate left  Rotate right SaVing

[Folder] tab sheet

gy MOOMCRZ g MEMOMCRZ g CTREE SNy MCOOTNEEE le) WGBSR

- ~ MGO0ECRE

Information dlsplay —— X199, 888) - 167,172,195 High quality Recipe data: Yes Number of images: 7 Nummber of selected images: 1 CMYK
Display mode Number of selected images CMYK simulation display
Recipe attachment status Number of displayed images

)
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)

Image Frame Information in the Main Window and Edit Image Window .10.p.31) eduetion
Information displayed when [Large thumbnail] (p.10) is selected
B Digital Photo Professional - [C:\Documents and SettingsicanonWy Documents'Wy PicturesiP hoto'woooc soc o] Contents at
File Edit Wiew Bookmark Adjustment Tools  Window  Help a Glance
.-—-\] e ‘_"'--.__llI _.'-Tﬂ\] -
=g ) N ﬁ Basic
Edit image o0 Select all Clear all Chacki Operatlon
windaw L
ll;nlder o | Callection () d d
- = Advance
r . a :
Check mark Eg Esﬁipmwments s o Copy stamp mark Operation
(p.17, p.18) g My Music (p.61to p.65, p.94
i . to p.98
= = gP;;t;tr:s - g p.98) Advanc_e_d
ig— Lens aberration Image Editing
vj Mty Cormputer correction mark 9
&) My Metwork Places & (p.59)
) Travel S Processing
Trimming range*® Large Numbers
(p.35, p.92) of Images
Brightness adjustment v S
value*! (p.24) L & - 3 Editing
Aperture* JPEGITIFF
| | 1 | Images
White balance icon o 1‘ . - TS Lo |
(p.25) ' ¢
: | Reference
|
. RAW adjustment mark*1 *4
File name RGB adjustment mark*! *> nd
ndex
Image type*? Unsaved editing content mark
Shutter speed*3
*1 Does not display with [Small thumbnail]. *4 Displays in an image edited with the [RAW] tool palette in the edit
*2 Displays in RAW+JPEG images displayed as a single image (p.20). window and the edit image window.
[RAW] is displayed in RAW images. (In [Small thumbnail] (p.10), [R] is *5 Displays in an image edited with the [RGB] tool palette in the edit
displayed.) window and the edit image window. @
In PowerShot Prol RAW images, [RAW] is not displayed. *6 When aspect ratio information is attached to an image shot with the w
*3 Does not display with [Medium thumbnail] or [Small thumbnail]. EOS-1Ds Mark Il or EOS-1D Mark 1ll, the image is displayed as a

trimmed image.
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List of Edit Window Functions .11, p.23

Path and file name of image

' Digital Photo Professional - [C:\Documents and Settingsicanoniy Documenis\y Pictures\P hotoboooc soc sodMG_0001.CR2]
File Edit ‘Wiew Adjustment Tools  Window  Help

(24281580 ; 40, 60, 32 HighI fuality F{PquI" Adobe RGE ON:IYK

EEX

Tool palette*! (p.107, p.108)

IMG_0001.CR2 =
RéW | RGE | NR/Lens |
Brightness adjustment I
3 oo |
White balance adjustrnent ") I
|Shotseﬂings v| Tune...
Ficture Style =1 |

|Btandard v| Browse...

-100 -80 -60 -40 -Z0 00 20 40

Contrast: {0} —r—
[ Linear

Colortone:{0} —_—r

Color saturatian:(0) ——

Sharpness:(1) —

Information display*? CMYK simulation display (p.74)

Display mode** Image color space*3 and work color space (p.65, p.74)

*1 To switch between show/hide, select the [View] menu » [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.70) of the
[Preferences] window is displayed.
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List of Tool Palette Functions
RAW Tool Palette (p.23)

IMG_0001.CR2

IRGE | NRALens |

Brightness adjustment

] == Brightness adjustment (p.24)

White halance adjustment

22 | [ Register White balance adjustment
' Bhot settings v [ Tune_ (p.25, p.26, p.52)
Ficture Style

Standard Picture Style settings (p.24, p.53)

Dynamic range adjustment (p.53)

0o Zo 40
—+—1}4— Contrast adjustment (p.27)

-10.0 -80 -60 -40 -20
Contrast: (0)

[JLinear
Caolar tane:{0)

Linear setting (p.27)

e . Color tone and color saturation
O adjustment (p.27)

&~ Sharpness adjustment (p.29)

Color saturation: ()

Sharpnessif1)

— Enlargement display position*!

RGB Tool Palette (p.55)

IMG_0001.CR2 3]
RaW | RGE | NR/Lens

Tone curve assist

Automatic adjustment
(tone curve assist) (p.30, p.85)

(O] ]2
Tone cune adjustment = |

(ree_J(RJ(c] # H— Click white balance (p.87)

255 |

Tone curve adjustment
(p.54, p.89)

—— Dynamic range adjustment (p.90)

Brightness: - sl & === n
' L o Brightness and contrast
- I o | adjustment (p.86)
Hue: =1 . :
2 [: : °! Hue and Saturation adjustment
aturation: 3 ﬂ 100 (p.88)
Sharpness: T] E ]

Sharpness adjustment (p.88)

—— Enlargement display position*!

*1 If an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears when
[Docking display] (p.73) has been set and the edit image window (p.110)
has been enlarged.
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Introduction

NR/Lens Tool Palette (p.56) NR/Lens Tool Palette (p.91)
(When a RAW image is selected) (When a JPEG or TIFF image is selected)
[ — Contents &
raw | ReB || NRLens | Rewv | RGB | MRILens
Noise reduction | Noise reduction |
rRAW_ . — . RAM Basic
Luminance noise reduction:(0) . - . Operation
3 Luminance noise reduction for
L 0 m RAW images (p.56)
( Chrominance noise reduction:(0) A . . . Advanced
3 Chrominance noise reduction for Operation
L 0 mo RAW images (p.56) i
TIFF or JPEG TIFF or JPEG Advanced
Chrominance noise reduction: (&) Image Edl_tlng
J L Chrominance noise reduction for and Printing
0 10 JPEG and TIFF images (p.91)
Processing
(i - Apply NR button (p.56) [AmswiE = {— Apply NR button (p.91) Large Numbers
4 of Images
Lens aberration correction Tune... ns aberration co
Peripheral illumination BIER arifhy T ZAEia Editing
Distortion off  F— Lens aberration correction (p.59) Distn JFI)nEgg/j-I(;IsFF
Chromatic aberration CFF AL
Colar blur OFF
1 Reference

— Enlargement display position*! Enlargement display position*1

Index
*1 If an image is displayed enlarged, the enlargement display position @
can be moved by dragging. The enlargement display position appears

when [Docking display] (p.73) has been set and the edit image
window (p.110) has been enlarged.
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List of Quick Check Window Functions .16, p.17)

Check mark display

50% view/100% view (moiré reduction off)/full view*!
Path and file name of image Displays the image in full screen*?

' 2/15 C:\Documents and SettingsicanoniMy Documents\iy PicturesiPhotoboooc soc sodIMG_0002.CR2 |;|[E|E|

[ 0% view H Full screen ] Removes check

Check mark [ clear H—— marks (pl7)
[ 2 ][ = Jf—— Check marks (p.17)

l Prel\riuus “ Mext ] .
' ' Switches between
displayed images

—— Displays the image

[ Image Information I lnfOFmatlon W|ndOW
[ Ratate et H Rotate right ] (p.22)

' ' Image rotation
(90 degree units)

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Tools] menu and using [Quick check tool display]
in the [View settings] tab sheet. You can also move the display
position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.
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List of Edit Image Window Functions ©.1.p.33

Shows/hides tool palette Image path and file name
Shows/hides thumbnail display area Shows/hides Enlargement ratio of displayed image Image rotation (90 degree units)

Switches to main window (p.103) Switches between displayed images Batch conversion/saving

[& Digital Photo P ents and SettingsicanoniMy DocumentsiMy PicturesiPhoto! (p ) ] p )

File Ecjt Yiew Adjustment Tocls Help

n D @ 2 ®

Rotate left  Rotate right

Toolbar

RAW |RGE MR/ Lens
|Elrighlﬂess adjustment I
.

|Wh|te balance adjustment =) |

wd Register

|Shot settings v‘ Tune...
[Picture Sty =
‘Standard v| Browse...

——Tool palette
; (p.107)

Thumbnail display area*3

-io0 -0 -60 -40 -20 00 20 40

Contrast: (1) ===
[ Linear

Color tone:m) —l—

Colar saturation:(0) —ip—

Sharpness:(1) —

Display mode*>

Information diSplay*2 ——————{ammea0an 116131177 Hign S, RAW / Adobe FGE_ GMYK ——
\ [

CMYK simulation display (p.74)

Image color space*! and work color space (p.65, p.74)

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences]
(p.72).

*> The item selected in [Viewing and saving RAW images] (p.70) of the
[Preferences] window is displayed.
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)

List of Convert/Save One Image Window Functions s e etion
Convert and save ﬁl&l
P = Contents at
_ Save in || (3 Photo ¥ 02 @ a Glance
Types of image
Type of image Extension uﬁ Basic
Exif-JPEG JPG St Operation
Exif-TIFF 8bit TIF =
TIFF 16bit TIF -
Diesktop ORI At Advanced
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Save destination Operation
TIFF 16bit+Exif-JPEG | .TIF/.JPG __j
b p Documents Advanced
Image Editing
alj and Printing
i by C;Jmputer
File name i . Processing
: ‘ Large Numb
..‘]H_) File name: !ﬂm L | L_ Save +7 Save atl;%elm:r;esers
My Metwork | Saveaslyper | ExitPEG(" JFG,"JFEG) sl [ Cancel |
: : Editing
Qualily sotig . JPEGITIFF
= . I & JPEG compression rate*3 Images
Resolution*1
Cutput setting
Output resolution | 350 dpi QEmbed 1CC profile inimage
Embeds of ICC profiles*2 (p.117) Reference
Resize sefting )
[[Resize
Size changing*4 [ s Index

Q0
)

“—

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.65, p.74) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65,
p.74), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming Window Functions 35092
Cancels all the trimming (aspect ratio) information
- B
[ Furssreen H——Full screen display/returns to normal screen

clear ][ Rresst —— Reverts to the condition when the image was shot

Aspect ratio

' 1115 C:\Documents and Settings\My Documents\My Picturesooor s odIMG_0001.CR2

Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you
can also enter numerical values)

e T Size 01_‘ trimmed range (you can also enter
t980  |x[13m | numerical values)

i Copies the trimmed range and applies (pastes)
(T it to another image*?
~on i —————Applies the copied trimming range to all other
|_T_|Show borders images*z

o Displays borders around a trimmed range

1 —Level of opacity outside a trimmed range

ous )|— Switches between displayed images*2

" A
1037 a04

(=]
=
[y
o
=
=
C

{1037, 5047 - (3026, 1830 = (1989 x 1326) [ 1.50]

Trimming range

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming
window is displayed.
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List of Lens Aberration Correction Window Functions ¢ 59

Introduction

" Lens aberration correction - [IMG_1001.CR2]

: Contents at
ﬂ a Glance
. . Basic
— Enlargement display section*! Operation
Advanced
Operation
— Reverts to the condition when the
roAm v image was shot
agiing aistance nmrrmaton
———— 3+ Shooting distance information I
. Image Editing
- - slider (p.60) and Printing

E1Reripheral illumination [ Peripheral illumination correction

Processing
el Distortion correction La(r)%einl:lgr;gsers
B "ogetenation Chromatic aberration correction E—

+——+— Corrects blue chromatic aberration JITrEgé'I(;ISFF

Color blur correction

Shows/hides position of
enlargement display section

Reference
Grid display
| cancel
Index
Enlargement display position Corrects red chromatic aberration

(Navigator display) @ @

*1 The area you clicked on the image (Enlargement display position) is

displayed at 200%.
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List of Copy Stamp Window Functions .61 top.65 p.94t0p.9s)

' 1f 2 C:\Documents and Settingsicanon'dy DocumentsiMy Pictures'\Photolwooot_soc sodMG_0050.CR2 [3456 x 2304] |Z||E|r5_?|
| 10mview || Funscreen H— Full screen display/returns to normal screen

[ Apply Dust Delete Data 1——App|les Dust Delete Data (p61, p94)
Repair Repalr

Lk ‘ 2o M—Types of dust to be erased (p.63, p.96)

—|— Specifies the copy source (p.65, p.98)
[JFix copy souree position —— Fixes the copy source position (p.65, p.98)

-
Fen type

TN L " .= - i § @ Brush O Pencil Types of Stamps (p65’ p98)

Sets the size of the dust erasure range (p.63,
p.96) or copy range (p.65, p.98) in a range of 5

>
Radius

g~ B to 100 (in one pixel units) (you can also enter a
numerical value)
Redo
v . Restores/redoes the image
KRN Copies the dust erasure range or copy range

] and applies (pastes) it to another image
— Switches between displayed images*

Sef ko 100% view ko perform stamp operation

* Operates when you have selected multiple images and the copy
stamp window is displayed.
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List of Convert/Save Multiple Images Window (Batch Processing) Functions o) e etion
Batch settings
) . IMG_0001.CR2 Tave folder o Contents at
Flle names Of Images to be mg—ggggggg [ 'C:‘tDocumentS and Settingsicanonibty Dﬁcumentsl Save deStlnatlon a Glance
batch saved IMG_0004.CR2 :
IMG_0005.CR2 File format
e sa0r 20 (Kind of file Exif-JPEG v ) Types of image Basic
| IMG_0008.CR2 Image qualty 1 10 : - Operation
IMG_0010.CR2 Type of image Extension
Embeds ICC profiles*2 (p.117) e PRI P o Exif-JPEG JPG
IMG_0013.CR2 Outputresalution | 350 | dpi Ermbed ICC profile . .
Resolution*1 w o ———— ' EXIF-TIFF 8bit aks gg\é?gtcigﬁ
— e TIFF 16bit TIF
, . Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG
Size changing*4 : _
TIFF 16bit+Exif-JPEG | .TIF/.JPG Advanced
Image Editing
(| and Printing
(" File name —— JPEG compression rate*3
O Currentfile name Processing
i Large Numbers
g | of Images
m;f:;me e File name
0 . Sequence num Editing
- T B JPEG/TIFF
[[] save sequence number Images
Ex: DPP_000M.JPG, DPP_0002JPG..
Image transfer setiings . N Reference
MRiage using SOt Batch transfer to other image editing
| software (p.81)
f Save
Images to be converted are [~ ConvertRawiimagesonly  |[  Execute ' ][ cancel | Index
limited to RAW images*>
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.65, p.74) information that is set in an image is attached the image quality becomes. @ @
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65, *5 Appears when you click the [Batch process] button (p.103, p.110)
p.74), the ICC profiles are embedded automatically. without an image selected in the main window or the edit image

window. To convert RAW images only, instead of clicking the [Execute]
button, click this button. 115



List of Rename Window Functions rs2)

Order in which images are sorted

Check mark to apply the same
name to RAW images and JPEG
images recorded simultaneously

=’ |C:ADocuments and Settingsicanon\WMy DocumentsiMy PicturesiPhotobooor dac xod

——(

Check mark to copy the images
Click the [Browse] button and set
the save destination

rFile name Extension ) .
| DFP + | Shooting DateTime vH Seguence number vi iDo not change v! Sets the new file name
\\a J
( Basic Settings ( Format settings )
Sort Sequence numhber
G Fitta main window | oot | [save sequence number
@l Shooting DaterTime . .
| O Shooting DaterMime . Sets the format of information
|‘r‘earru10nth Day v| . .
) in the file name
["¢-h-DD v
( [ copy Rename )
Insert underbar
\ J
Qriginal File Mame Modified File Mame

IME_0001.CR2 A CPP_06-08-13_0001.CR2 A

IMG_0001.JPG T DPF_0E-08-13_0001.JPG i

IMiz_0002.CR2 = DPF_06-058-13_0002.CR2 =

IMG_0002 PG CPP_06-05-13_0002JPG

IMiz_0003.CR2 i | CFPP_06-09-13_0003.CR2 B

IM_0003.JFPG DFP_06-08-13_0003.JPG

IME_0004.CR2 = CFP_06-08-12_0004.CR2

IMiz_0004 PG CPP_06-09-12_0004.JPG

IMiz_00048.CR2 DPP_06-08-13_0004.CR2

IME_0005. PG DPP_06-05-13_0005.JPG

Iniz_0006.CR2 v DFPP_06-09-13_0006.CR2 v

Execute l l Cancel
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
you view on a monitor and the color of an image you have printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

|ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard .
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than SRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of ";‘naggﬁgt'it;]”gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y 0 .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. Editing
Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between Images
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. s . ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an
value (color temp.) image, you can print a natural-looking image in @ @
— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
[ Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K (D65) cases where the overall tone of an image
————- ColorMatch RGB 1.8 5000K(D50) cha_nges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and hlghllghts Change. 118




Index

A

AdJUSE JPEG IMAQGES ... ittt eeeeeeeeeeeeeeeeeeeeenneeeeees 84

AdjUSt RAW IMAQGES....uuuuiiuriiiiiiiiiiiriiiniirisistssrsssssssessassessssssssseesrnnrnre. 23

AJUSE TIFF TMAQJES. ... uuueiiiiiiiiiiiiiiitiiitiitiiieeeiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 84

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt).......ccooeeeieeieciiiieieenns 85
BIIGNINESS ...ttt 86
Click Whit€ BalanCe .......covuiiiiiiiiieeei e 87
(O70] 011 7= 1S R 86
DYNaMIC RANGE .....iviiiiiiieeeieeeeeeeeeeeee e 90
i 10 L= 88
RGB TOOI PAIELE ....eeeeeeeeeee e 84, 107
=100 [ = 11T ] o I 88
S =T 0] LSS PPPP 88
Tone Curve AdjUSIMENT......ccooiiei e 89

Adjusting (RAW image)
APPLY AdJUSTMENTS ... 78
Automatic Adjustment (Tone Curve ASSISt).......ccoeeeeieeiieeiieiiiennns 30
BIIGNINESS .vvviieiiiiiiieeeeee ettt ea e 24
Click White BalanCe .........cooeiiviiiiiiie e ee e 26
(OF0] (o] g Y= 1 (U] 7= 110 ] o 27
(7] (o g =10 0] 0 1=T 7= (0[S SRR 52
(©F0] (o i 1] £ [T T 27
(OF0] [0 YA g T<T=] T 52
(O] 11 =1 S 27
(070 o)A AV 18111 41T o £ 78
DyNamiC RANQE.......ccuuuiiiiii e 53
[ L] g 1 (=T A 28
1Y/ Lo 1 a1 (] 1 1[I 28
Personal White BalanCe ...........oovveiiiiiiiiii e 79
PICIUIE SEYIE e 24
Picture Style File ......uvveiiie e 53
RAW TOOI PaAlBte ...uviiieeiee e 107
SaVE AGJUSTMENLES ....oiiiiiiieiiiiieeeie e 78
SNAIMPNESS .o 29
Tone Curve AdjUSIMENT........ooiiiiiiiiiieeee e 54
ToninNg EffeCt ..o 28
LN Y01 2= 11T 1 12,107, 108
WHItE BaAlANCE . ccvniieeiie e 25

Adjustment Contents (RECIPE)........uuvvurreerrreriirreeeererereeeeeeereeaneeeees 77,117
AdODE RGB ... 118
APPIE RGBh...cciiiiiiieieeeeeeee ettt 118
AITaNgE IMAGES ..ot aeaaeeees 18, 19
Automatic Adjustment (Tone Curve ASSISt) .......ccvvvevveeiiieiiieiieneen, 30, 85
Automatic Dust Erasure Processing.......cccccveeeveeveeeeeeencens. 61, 62, 94, 95
B
Batch Apply White Balance to Images (Personal White Balance)....... 79
Batch Change the File Name of Images.........ccccccevviiiiiiiiiiieeieeeiie 82
Batch Convert/Save Images (Batch Process) .......ccccccceeeevveeeeevveeinnnnnn, 80
Batch Process (Batch Save JPEG and TIFF Images)................. 80, 115
Batch Process of Multiple Images
Change File NamMe ........coooiiiiiiiiie e 82
Convert/Save (BatCh ProCeSS).........uuuvvvvvrvveerrrerienireerrnnrnennns. 80, 115
Personal White BalanCe.............cccoooiiiiiiiiiiiiiiiiiieee e 79
RECIPE DALA ....covvvviiiiiiiiiiiiiieee 77
L= 105 (= R 81
Batch Settings WIiNAOW..........ccoooiiiiiiiiieees 80, 81, 115
Batch Transfer IMages .........ccoceeuuuiiuiiiiiiiiiiiiiiiiiiiievvvere e 81
Batch Transfer Images to Image Editing Software...............ccccoeeuvinee. 81
Before/After Comparison DiSplay .............eeeuvevieeiireviiiiieiieeeiieeeeeeeeeeeen 49
DIt NUMDET ... e e e e 117
BOOKMArK ... a7
BIIgNINESS ... 24, 86
C
Change File Name.........cooooiiiii s 82
Changing the File Name of Images in the Order in the Main Window. 82
Check Mark ..o, 17,18, 105, 109
Chromatic Aberration COrreCtion ..........ccoeeeeieeeieeeeeeeecees 59
Chrominance Noise Reduction (JPEG, TIFF Images).......ccccccceeeeennnn. 91
Chrominance Noise Reduction (RAW IMages) .........ccccvvvvevveeiniiiinnnn. 56
Click White BalanCe..........cooooviiiiiiii 26, 87
CMYK SIMUIALION +.ieeeiiii ettt e e 74,75, 118
Collection WINGOW ........cuuiiiiieeeeiiiiiiiiiee e 6, 33, 104
(670 (o] gl =] [V g 014 =Tox i o] o S 59
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(0] 0] g ©1 o F- T SR PPTPPPPPRPR 118
Color Management (Color Matching)..........ooooeeiieiieiiiieeeeeeeee s 117
Color Setting of the Monitor (Profiles) .........cccccvveviieiiviiieeiiieiieeee, 74
Color Setting of the Printer (Profiles)........ccccovvvieeiiiiiiiiiinnnen, 74,75
COlOr SPACE.....ci ittt 118
ICC Profiles ..o 117
Color Management (Preferences)..........cvveviiiiiieiiieeeeeiiiiiieeeee e 74
Color SAtUratioN .......cooviiieeieee e 27
Color Setting of the Monitor (Profiles).........c.occocvviiiiiiiiiiiiiiiceeee 74
Color Setting of the Printer (Profiles) .........cccvvvviiieiiiiieeeeeein, 74,75
COlON SPACE ...t 118
AdObEe RGB ... 118
APPIE RGB ..o 118
Color Space Setting for Each Image ..............eeeveeieeiieeiiiiiieeiiennenn. 65
(7] (o 141V =1 (o1 I 2 L €1 = SR 118
Default Setting of Color Space .......cccccvvvvvvvviiiiii 74
SRGB ... s 118
Wide Gamut RGB ... 118
Color Space Setting for Each Image..........cccooeeeeiii, 65
Color TEMPEIAIUIE.....cceeeeeiieeieeeeeee e, 52
(O] (o] g 1o 1= 2R 27
COlOr WNEEI ... 52
ColorMatCh RGB........ooiiiiiiieee 118
Compatible Cameras with the Lens Aberration Correction Function.. 57
Compatible Lenses with the Lens Aberration Correction Function..... 58
Contact Sheet Printing (Printing a Thumbnail List)............................. 67
CONTIAST . et 27, 86
Convert to JPEG or TIFF Image and Save................... 38, 80, 111, 115
Convert/save One Image Window .......ccccooeevvvvviviiininneeeeceeeeeinnnn, 38, 111
Copy Stamp (Image COrrection) ...........eeeeeeeriiiiiiiieeee e 65, 98
Copy Stamp WINAOW ......cceeviieiiiiiiiiiiiiic e 61, 63, 94, 96, 114
Copying and Pasting (Applying) RECIPES.........cccuvviiiiieiiiiiiiiiiieeeeeee 78
Correct Images (Copy Stamp Function) .........cceuveeeinnieeeereeeninnnnnn. 65, 98
Creating @ FOIUET ... 45
D
Default Noise Reduction Settings ..........cccuvvveiiieeiiiiiiiiiieeeee e 73

Default Setting of COIOr SPACE .........uvvvviiviiiiiiiiiiiiiieiiiiiieeree e 74
Delete IMAGES ....ccoiiiiiieie et 45
Deleting
Delete IMagesS.......oovviiiiiiiieee 45
Delete the Software ..., 102
Deleting DPP (Uninstalling) ........cccoooeiiiiieiiicccccc v 102
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Display
Before/After Comparison Display ..., 49
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Edit IMage WINAOW...........uuuuiiiiiiiiiiiiiiiiieiiieeieeieeeeeeeeeeeeeeeeeeeeeeaeees 31, 110
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EXItING DPP ... 14
F
False Color REAUCTION .....cuviiiiieieeeeee et 70, 71
Filter EffeCt. ... 28
(00 [0 L gAY AT o Lo [0 1YY T 6, 103
G
General Settings (Preferences) ..., 70
H
L 1= o P PSPPPPPRP Cover
Highlight Area Warning INdiCator ................ueveeueeiiiieieeiiiiiieiieeeeeeeieeeeee. 51
HUB e 88
I
ICC PrOfilES ...ttt e e e 117
Image Frame Information (Image Marks) ........cccccvvvviiiiiieeeeeeeeiinnnnnn, 105
Image Marks (Image Frame Information) .............ccccvvveeveeennnniiiinnn. 105
Image Quality
Default Noise Reduction Settings...........cvvvvvieiiiiiiiiiiiiee i 73
False Color REAUCHION ..........uuviiiiiieiiiiieece st 70,71
Improve the Quality of an Image (Main Window) ..........cccccvvvuennn. 21
Noise Reduction of a JPEG Image (Chrominance).........ccc.......... 91
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 56
View and Save a RAW Image ..., 70, 71
Image Shooting Information DiSplay ...........c.eeevveieiiiiiiiiiiieeeees s 10, 21
Improve the Quality of an Image (Main Window)..........c.cceeevvvvvvininnnn. 21
J
JPEG IMAGE.....ei e 117
L
Lens Aberration COrrECHION .......ccooeeiieeii e eeeeeeeeeeeeees 57
Lens Aberration Correction Window ...............cccuueeeeeieeeinieneennnnns 59, 113
1< ST 27
Loading and Pasting (Applying) RECIPES ......coeeevvvvviiiiiiiiieeeeeeeeeinn, 78
Luminance Noise Reduction (RAW IMages) ........ccccvvvrrveeeiiiiiiiineneenn 56
M
MaiN WINAOW ... 10, 103

Manual Dust Erasure (Repair FUNCLION) ..........c.ccccuvvvvvvviviniiniiininnnns 63, 96
MONOCNTOMIE. ... eeeennennee 28
FIlter EffEC.....i e 28
TONING EffECT....iiiii e 28
MoVeE Or COPY FOIEIS .....coeiiiiiiiieee e 46
MoVE OF COPY IMABGES ...vviiieiiiiii e 46
N
Noise Reduction (JPEG or TIFF IMage)...........uuuueeeeeimeeeieeiiiieeieeeeeeeenn. 91
Noise Reduction (RAW IMAJE) .....uvvrrrriiiiiiiiiiiieiieieeieeeeeeeeeeeeeeeeeeeeeaaees 56
Noise Reduction of a JPEG Image (Chrominance) ...........ccccceeeeeeeeeee.. 91
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 56
NR/Lens TOOI PalEtte ... 108
@)
Organize IMagES ...cooeeeiee e 45
Organizing IMAJES .......uuuueeeieeiiiiiiiiiii e 45
Create @ FOIUEN .......uuiiiieiiiiiiiiiiiiitie ittt eee e 45
Delete IMAgES ......ooiiiieiieiiiee e 45
Move or Copy FOIErS..........ooviiiiiiiiiiiee e 46
Move or CopY IMAGES .......covviiiiiiiiiie e, 46
Register Folders as BooOKMarks.........ccccccvveveiiiiiiiiiiiceee 47
P
Peripheral lllumination CorreCtion ................eevveeveeereeeeeeeeeeeeireeeeeeeeeeees. 59
Personal White BalanCe ..............uuuvuuiiiiiiiiiiiiiiiieiiieeiieieeeeeeeeeeeeeeeeeeeeeens 79
PICUIE SEYIE oo e 24
Picture Style File.......cceeieiieeeeeeee e 53
PrEfEIEINCES ...ttt e e e e 70
Color ManAQEMENT .......coeiiiiiiiiiiie e 74
GeNEral SENGS ..vvvvuviriiiiiiiiriiiiieiiriiere e 70
TOOI Palette ... ..o 73
VIEW SEHINGS 1eevvtiiii i i e e e e e e e e e e e e e e e e e et s e s e e e e e eeeannes 72
Printing
Printing a Thumbnail List (Contact Sheet Printing) ...................... 67
Printing One Sheet of Paper.......cccccceeeivieeviieiiccie e, 14, 44
Printing Using Easy-PhotoPrint..........cccoooeeeviiiiiiiiii e, 42
Printing Using Easy-PhotoPrint EX............cccc, 39
Printing with a High-End Canon Printer ............cccccceeviiiiiiiiinenenn. 68
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Printing with a Large-Format Canon Printer..........c.cccccoeeeeeei. 69
Printing with a Printer other than the Canon Printers.................... 44
Printing with Canon Inkjet Printers ..........ccccccevviiiiiniieeeenee 39, 42
Printing with Easy-PhotoPrint Pro ...........cccccccviiiiiiiiin 68
Printing with Shooting Information (Detailed Setting Printing)...... 66
Rendering Intents when Using Easy-PhotoPrint ................... 74,75
Printing a Thumbnail List (Contact Sheet Printing) ..........cccvvvvvvvveene... 67
Printing One Sheet of Paper ... 14, 44
Printing Using Easy-PhOtOPTINt.............uuuuviiiiiiiiiiiiiiiieiiieiieeeeeeeeeeeeeeeee 42
Printing Using Easy-PhotoPrint EX.............uuuiiiiiiiiiiiiiiiiiiiiiieeeeeeeieeeeee, 39
Printing with a High-End Canon Printer ............cccccvvvvvvvviviveeeeeeeeeeeee, 68
Printing with a Large-Format Canon Printer ............cccccvvevveevveeeeeennen.. 69
Printing with a Printer other than the Canon Printers...........ccccccvvue..... 44
Printing with Canon Inkjet Printers.............cccvveeeiiiiiieiiiiiiiiiieeeeeee, 39, 42
Printing with Easy-PhotoPrint Pro...........cccuvvvvvvviiiviieiiiiiiieieeeeeeevvveeee 68
Printing with Shooting Information (Detailed Setting Printing) ............ 66
Q
QUICK CheCk WINOW........ccvviieiiiie e 16, 109
R
RAW IMa0E. .ttt s a e raeab e aees 117
RAW TOOI PAIEIE ... e 12, 107
Re-Adjusting @n IMAQJE ........uuurvriiiiiiiiiiiieieiieeieeeeeeeeeeeeeeeeeeeseseeeeeees 39, 99
RECIPE .. 77,117
RECIPE FlE oo 77
Re-Editing an IMage ...........uuuuuiuiiiiiiiiiiiiiiiiiiiieeeieeeeeeeeeeeeeeeeeeeeeeeeees 39, 99
Registering Folders as BOOKMArKS .............uuuvvuveiiiiiieeiiieiireeeeereeernnenee. 47
RENAME WINAOW. ... e e aaas 82, 116
Rendering Intent (Matching Method) ............evvvviviiiiiiiiiiiiiiiiiiiieeeeee, 118
Rendering Intents when Using Easy-PhotoPrint .................... 74,75
Rendering Intents when Using Easy-PhotoPrint..............cccccoee. 74,75
Repair (Manual DUSt Erasure) .............eeeeeeeeveeieeeeieeiieeieeeieeeeeeeeeen 63, 96
RGB TOOI PAlBE .....ieeieiee e 84, 107
Rotate Images......cccoovvvvviiiiiieiieecee e 10, 23, 103, 104, 109, 110
S
SAUFALION....ciiiiei i 88

Save
Batch Convert/Save Images (Batch Process)...................... 80, 115
Convert to JPEG or TIFF Images and Save .........ccccceeee..... 38, 111
AV ettt 37, 98
SAVE AS .ttt ettt e e et e e e e e e e e 37, 98
Save JPEG or TIFF Image as a Separate Image ...........cccceeveeeens 99
View and Save RAW IMages .......ccooeeeeiieieiiiieeenes 70, 71
AV A S et 37, 98
SaVING RECIPES ... 78
SeleCt IMAageS....coo v, 10, 16, 31
Shadow Area Warning INdiCator............cooeeeiieeiiiieececccees 51
SNAIPNESS ... 29, 88
Shooting Information Display.............ccccooeiiie 10,21
SNOMCUL KBYS ...ttt iieeiie et Cover
Single Image Display ..o 20
Single Image Display of RAW and JPEG Image .........cccoeeeeiicccccnnnnns 20
Sorting Images (Check Marks) ..., 17,18
SIREE ..., 118
Starting UP DPP ... 6
SUPPOrted IMAGES ... 3
Synchronization (Edit WiNndOW)............oooooiiiiiiiii s 50
Synchronize Edit WINAOWS .........oouiiiiiiiieiiiiieeee e 50
SYNChroNize IMAagES .......ccooi i 50
SyStemM REQUITEMENTS ......oiiiiiiiiiiiiiiiiie et 3
T
Thumbnail Display (Main Window) ..........cccovvuviiiiiiieeeeeeeeeeiiinnnn 10, 103
Change the DISPlay.........coouuiuiiiiiiiieeiiie e 10
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 31
Thumbnail Display of Images (Main Window) ..............cccooeeieeiiiiieens 10
Change the DISPlay..........couiiuiiiiiiiiee e 10
LI 11T T T 117
TONE CUINVE ... et e s 117
Tone Curve AdJUSTMENT........cooiiiiee e 54, 89
Tone Curve Assist (Automatic Adjustment)..........cccceeevvvivinneneeenn. 30, 85
TONING EffECT ... 28
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Tool Palette

NR/Lens TOOl PalEtte .........eeueeiiiiiiiiiiiiiiiiiieiieeeeeeeeeeee e 108
RAW TOOI Palette.....uvuiiieiiciiieicee e 107
RGB TOOI PAIELLE ....covieeeiiiiiiiiiiiiee e 107
Tool Palette (PreferenCes) ........uuvveiieeeiiiiiiiiiieiieiiieeieee et 73
Transfer
Batch Transfer Images to Image Editing Software...................... 81
Transfer an Image to Photoshop...........cccceeiviiiiiiiiecccii e, 65
Transfer an Image to PhotoShop ... 65
THAMMING @N IMAJE ...evvviiiieiiieiiieeeeieieeeiee e e eeeeeeeeeeeeees 35, 92
TrmMMING WINAOW ......evviiiiiiiiiiiiiiiiiiiiiiiieiieeeeeeeeeeeeeeeeeeeeeeeeee 35,92, 112
\%
View Settings (PreferenCes) .........uuvvvvviiriiiiiiiiiiiiiiiriieeeeereissseeeseeenneeen 72
W
WHhite BalanCe.........uuiiiiiiiiiiece e e 25
Click White BalanCe .............uuuuuiiuiiiiiiiiiiieiiiieiiiieieeeeeeeeeeeeeeeeee 26, 87
COlOr TEMPEIALUIE ....eeeiiieiiiieeeee e 52
COlOr WREEI.....eiiiiiiiiiiiiii et eeees 52
Personal White BalanCe .............coeieeiiiiiiiiiiiiici et 79
Wide GamUEt RGB .......uuiiiiiiiiiiiiiiiiieeee ettt e e 118
WOTK COlOr SPACE......eeiiiiieiiiitie et 65

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

© Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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